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Overview
Welcome to the Digitized Shape Editor User's Guide!
This guide is intended for users who need to become quickly familiar with the product.
This overview provides the following information:
●

Digitized Shape Editor in a Nutshell

●

Before Reading this Guide

●

Getting the Most Out of this Guide

●

Accessing Sample Documents

●

Conventions Used in this Guide

Digitized Shape Editor in a Nutshell
Digitized Shape Editor
is a powerful application used to read, import and process parts digitized to clouds
of points. These clouds of points can then be used in Quick Surface Reconstruction, DMU or Surface Machining
or exported to various other formats.
Digitized Shape Editor :
●

proposes several import formats,

●

takes special characteristics of imported shapes into account (free edges, facets, ...), if requested,

●

●

ensures a fast processing of clouds (that may contain several millions of points) through filtering, activation
and removal functions,
makes the manipulations of the various elements constituting cloud of points (points, scans, grids, meshes)
easy,

●

provides edition functions such as merging and aligning of clouds, or creation of planar sections,

●

provides display and analysis functions of the cloud,

●

keeps the architecture of objects processed,

●

provides tessellations to be used directly with other applications or for visualization,

●

exports the models created to several formats.

The Digitized Shape Editor user's guide has been designed to show you how to import and edit digitized parts
using these powerful tools.

Before Reading this Guide
Prior to reading the Digitized Shape Editor User's Guide, you are recommended to have a look at the
Infrastructure User's Guide for information on the generic capabilities common to all products.

Digitized Shape Editor
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Getting the Most Out of this Guide
To make the most out of this book, we suggest that a beginning user reads the Getting Started chapter
first of all and the Workbench Description to find his way around the Digitized Shape Editor workbench.
The User Tasks section will provide you with more detailed operating modes.

Accessing Sample Documents
To perform the scenarios, sample documents are provided all along this documentation. For more information
about this, refer to Accessing Sample Documents in the Infrastructure User's Guide.
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What's New?
New Functionalities
Projection on plane
Capability to project a cloud of points or a mesh onto a plane.

Enhanced Functionalities
Align with constraints
A priority order can be applied to the constraints.
The 3D distance tolerance used up to R15 release has been replaced with the possibility to apply a
priority order on each constraints.
Circles and inverted or transformed elements are now accepted.
Lines can be oriented.
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Getting Started
The following tutorial aims at giving you a feel of what you can do with the Digitized Shape Editor. It provides a
step-by-step scenario showing you how to use key capabilities.
The main tasks proposed in the chapter are:
Starting the Digitized Shape Editor Workbench
Importing a File
Meshing the Cloud of Points
Checking the Quality of the Mesh
Creating Curves

All together this scenario should take 15 minutes to complete.
The final cloud element will look like this:

Digitized Shape Editor
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Starting the Digitized Shape Editor Workbench
The first task will show you how to enter the Digitized Shape Editor workbench
The only pre-requisites for this task is to have a current session running.
1. Choose Digitized Shape Editor from the Start menu.
2. The Part name dialog box may appear depending on the way you customized your session.
It provides
❍

a field for entering the name you wish to assign to the part,

❍

an option that enables hybrid design

❍

and another one that inserts a geometrical set in the part to be created.

For more information, refer to the Part Document chapter in Customizing section of the
Part Design documentation.

3. Click OK. The Digitized Shape Editor workbench is displayed and ready to use.

If you wish to use the whole screen space for the geometry, uncheck Specification in the View menu.
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Importing a File

1. Use the Start > Shape > Digitized Shape Editor menu to start the Digitized Shape Editor
workbench.

2. Click the Import icon

.

Push the ... button and go to the samples directory to select the Carmirror1.cgo_ascii file.

3. Check the Statistics option.
This opens a window in the dialog box with information on the cloud of points you are importing.
4. Push the Update button. The cloud of points is displayed with its containment box.

Digitized Shape Editor

Version 5 Release 16

5. If you rotate the cloud of points, you can see a vertical line of outliers.
Use the green arrows to remove those points.
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6. Click Apply, then OK to validate the import and exit the action.

Note that the cloud of points element is created in the specification tree,
with the name of the input file and the icon the Import action.
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Meshing the Cloud of Points
1. Click the Mesh Creation icon

and select the cloud of points you have imported.

Push the Apply button. The mesh is computed on the cloud of points.

2. You can see that some triangles of this mesh are not displayed.
If you increase the value of Neighborhood, you can see that more triangles are displayed.
Note that the Neighborhood value is represented by the green sphere on the screen.
Its size is updated as you increase or decrease the value in the dialog box.
You can pick the cloud to move this sphere to this spot.
3. Check Shading and uncheck Triangles for a better display of the mesh.
You can also select Carmirror1.1 in the specification tree and use the contextual menu to hide the cloud of points.

4. Once you are satisfied, click OK to validate the mesh and exit the action.
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Note that this time the cloud of points element is created in the specification tree,
with the name and the icon of the Mesh Creation action.
This is the case for all actions that generate a cloud of points, with the exception of the Import action
for files imported individually.
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Checking the Quality of the Mesh
Due to irregularities in the imported cloud of point, some problems may occur in the mesh generated from it.
Digitized Shape Editor provides a series of tools to check the quality of the mesh and to improve it.

Flip Edges
Mesh Smoothing
Mesh Cleaner
Interactive Triangle Creation
Decimate
Optimize
Information

Cloud Display Options

A first set of information is provided by the Information icon
1. Click the Information icon and select the mesh.

:
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You can see that there is one non-manifold edge.

Visual information are also provided by the Cloud Display Options icon:

1. Click the Cloud Display Options icon

and select the mesh.

Check the Free Edges, Non-manifold Edges and Flat options.

You can see there is one free edge, some non-manifold edges (displayed in white, see black
circle),
and that the seam between the rounded and the flat areas could do with some
improvements.

Now let's flip edges of triangles of the mesh, for a better respect of sharp edges.

1. Click the Flip Edges icon

and select the mesh. The mesh goes to flat visualization.

Depth determines the amplitude of the reorganization of the triangles.
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2. Click Apply. You can see that the sharp edge has been improved.
You can repeat this step several times until the result is satisfactory.

3. Then click OK to validate the action and exit the dialog box.
The initial mesh is sent to the No Show and replaced by a new mesh Flip Edge.1.
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The Mesh Cleaner provides more information on the mesh and some tools to remove defective triangles:

1. Click the Mesh Cleaner icon

and select Flip Edge.1.

Push the Analyze button. When a problem is found, the corresponding line is highlighted.
Check those lines.

2. The incorrect sites are highlighted on the mesh
(in white by default, you can change it in the Preview colors combo box).

3. Click Apply to remove the defective elements.
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You may click Apply several times to remove all defective elements.
Click OK when you are satisfied.

Removing non-manifold vertices has created holes in the mesh.

This can be corrected with the Fill Holes action:

1. Click the Fill Holes icon

and select Flip Edge.1.

The action searches the free edges of the mesh.
By default, the largest free edge, generally the outer boundary of the mesh,
is displayed in red, with an X label, meaning it is not candidate for hole filling.
The smaller free edges are displayed in green and are candidate for hole filling.
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2. Click Apply. New meshes are computed on the holes.

3. Click OK to validate the holes filling and exit the action.
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Creating Curves
Now you can create curves from this mesh:
●
from the free edge,
●

from a planar section.

1. Click the Free Edge icon

and select Flip Edge.1.

In the Free Edges dialog box, check the Curve creation option.
This opens a new dialog box: Curve from Scans.
In this dialog box change the Split Angle value to 30 and check the Curvature Analysis option.

2. Click OK in the Free Edges dialog box to create the curves and exit the action.
The curves are created in the specification tree.

●

If you modify an option or a parameter, do not forget to click Apply in the corresponding dialog box
to take the modification into account.

●

If you check the Curve creation option, you will create only curves (no scans).

●

If you do not check the Curve creation option, you will create only scans (no curves).
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1. Click the Planar Section icon
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and select Flip Edge.1.

2. Use the arrow to move the sectioning plane at the level of the seam between the rounded area and the flat area.

3. In the Planar Sections dialog box, check the Curve creation option.
This opens the Curve from Scans dialog box.
In this box check the Curvature Analysis option.

4. Click Apply in the Planar Sections dialog box and OK to validate the creation of the curves and exit the action.
The curves are created in the specification tree.
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User Tasks
Filtering by Sphere
Importing Files
Exporting a Cloud
Editing Clouds
Aligning Clouds
Meshes
Operations
Creating Scans or Curves
Display Options
Information
Analyzing Distances Between Two Sets of Elements
Transformations
Working with other Applications
Managing Geometrical Sets
Selecting Using Multi-Output
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Managing Digitized Shape Editor Documents
This chapter deals with the management of documents in Digitized Shape Editor.
Opening a new CATPart Document
Opening an existing Digitized Shape Editor Document
Importing Files from V4
Using the Keyboard
Saving a Digitized Shape Editor Part

Digitized Shape Editor
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Opening a new CATPart Document
This task shows how to open a new CATPart document and activate the Digitized Shape Editor workbench.

1. Select the File > New commands (or click the New

icon).

The New dialog box is displayed, allowing you to choose the type of the document you need.

2. Click OK.
3. Choose Digitized Shape Editor from the Start -> Shape menu.
The Digitized Shape Editor workbench is loaded and a CATPart document is opened.
The Digitized Shape Editor workbench document is made of:
●

the specification tree and the geometry area in the main window

●

specific toolbars (geometry creation and modification toolbars, analysis toolbar)

●

a number of contextual commands available in the specification tree and in the geometry.
Remember that these commands can also be accessed from the menu bar.

The specification tree is a unique specification-driven and generative tool,
which captures and reuses process specifications,
ultimately accelerating the design process.
It lets you concentrate the design effort on establishing the proper design specifications,
while leaving it to the system to compute or update the resulting geometry when required.
This specification tree can be customized using the Tools -> Options menu item, Tree tab.
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In Digitized Shape Editor, the cloud of points elements are created in the specification tree with the name
and
the icon of the generative command, with the exception of files imported individually
(one single file imported or several files imported, but with the option Grouped not checked)
that keep the name of the input file.
●

●

If you wish to use the whole screen space for the geometry, uncheck Specification in the View
menu.
You could also directly choose Digitized Shape Editor from the Start menu.
It would automatically open a new CATPart document.

Digitized Shape Editor
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Opening an existing Digitized Shape Editor Document

This task shows how to open an existing Digitized Shape Editor document.

1. Select the File > Open command (or click the Open

icon).

The File Selection dialog box is displayed. Browse your directories to select the CATPart document to open.
2. Choose Digitized Shape Editor from the Start > Shape menu.

The Digitized Shape Editor workbench is loaded and a CATPart document is
opened.

Digitized Shape Editor
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Importing Files from V4
This application includes unique two-way interoperability with CATIA Version 4 data and
benefits from the breadth of the CATIA Solutions Version 4 portfolio.
Version 5 data can be loaded and processed in a Version 4 session.
Similarly, Version 4 data can be read in a Version 5 session and converted to a Version 5 format for further
edition.
Refer to the Integration User's Guide for further details on how Version 4 and Version 5 interoperate.
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Using the Keyboard
Key

Command

Action

Activate Areas,
Shift Remove (Pick or Brush), Deselects selected elements
Split a Mesh or a Cloud
Shift Align using the compass

Moves the compass without moving the cloud

Shift 3D Curve

Activates/de-activates the Snap on elements option

Ctrl

Scan on Cloud

Previews the scan being created

Ctrl

Curve from Scans

Moves the split points

Ctrl

3D Curve

Projects a point on its constraining element
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Saving a Digitized Shape Editor Part
The available formats are

●

CATPart,

●

stl,

●

igs,

●

wrl,

●

model,

●

stp.
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Importing Files
This chapter deals with the methods used to import files.
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Importing Files

This task shows how to import digit files describing a cloud of points (scanned or computed) or a mesh.
We recommend that you import files in IGES 106 format using the dedicated Import icon rather
than the File/Open menu.
Available formats depend on the workbench you are working in.
Files import from ENOVIA is not yet implemented.
Use the MultiImport1.cgo_ascii, MultiImport2.cgo_ascii, MultiImport3.cgo_ascii from the samples directory.

Digitized Shape Editor
●

Ascii free,

●

Atos (the quality of the points can be taken into account),

●

Cgo,

●

Gom-3d (as points, scans, grids or meshes, the quality of the points can be taken into account),

●

Hyscan,

●

IGES (IGES Entities 116 are processed.
If the cloud to import is made of Entities 116 only, the result is a cloud of points.
Otherwise, the result is made of scans).

●

Kreon

●

Steinbichler (as points, grids or scans),

●

Stl (bin or ascii, with creation of free edges and facets, if requested).

STL Rapid Prototyping
●

STL files (bin or ascii, with creation of free edges and facets, if requested) (default option),

●

Cgo,

●

Ascii free,

●

IGES (IGES Entities 116 are processed.
If the cloud to import is made of Entities 116 only, the result is a cloud of points.
Otherwise, the result is made of scans).
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●

●

●

In Cgo, Ascii and IGES formats, you can not process more than 10,000 points at each import,
in one or several files, e.g. you can not import 4 files of 3,000 points each in one shot but you can import them separately.
This limitation applies to the input files (before Sampling or resizing with the bounding box).
If you try to import over 10,000 points in one shot, a fatal error panel is displayed:
Too many points for this configuration.
❍
If the Grouped option is active, no file is imported.
❍

●

If the Grouped option is not active, files are imported as long as the sum of their points does
not exceed 10,000 points.

Mesh Regeneration is not available on those files.

Shape Sculptor
●

STL files (bin or ascii, with creation of free edges and facets, if requested).

1. Click the Import icon

. The Cloud Import dialog box is displayed.

2. In the Format field, select the file format.

3. In the Selected File area, use the button ... to browse your directories and select a file.
4. Check the box Statistics to display information about the model you are importing.
If you want to import several files in one shot, please refer to the Grouped explanations.

5. In the Options field:

❍

Enter the Sampling percentage to apply;
The sampling value determines the percentage of points or scans or grids that will be read from the digit file.

❍

Enter the Scale factor to apply to the model, as well as the Unit used in the file.
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●

●
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If the extension of the file you have selected is consistent with the list proposed, the Format field is updated automatically.
Otherwise, be careful to enter the correct format in that field.
Once you have performed an import operation, V5 proposes the last entered file path and format as default.
If you click on ..., the last entered directory is proposed as default.
The File unit option is not relevant to the Steinbichler format, nor the Sampling percentage to the Stl format.
6. For some digit file formats, you may want to enter additional data that are displayed by clicking the button More>>
For Ascii:

For Atos and Gom-3d:

For Iges:

For Stl:

Direction and Delimitors apply to scans. Enter these data whenever you know them.
Minimal Point Quality is used to clean Atos file from invalid points.
The quality value of a point lies between 0 and 255 (low to high).
Choose a value to ignore points below that value:
❍

Minimal Point Quality value is 125:

❍

Minimal Point Quality value is 75:

System applies to the operating system (Unix or Windows NT) used to generate the binary data:
select Same if you know you are using the same operating system as the one used to generate the binary data,
Other for the other way, Unknown if you have no indication.
Free Edges is used to create or not the scans representing the free edges of a mesh:

or

Version 5 Release 16
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Facets is used to create or not the facets of the imported mesh:

or

7. Click Apply to display the cloud of points or mesh:

8. Push the button Update to display the bounding box of the cloud of points or mesh.
Use the green arrow to resize it in order to import only a part of the cloud of points or mesh.

●

●

●

The bounding box appears every time the cursor passes over a cloud of points or a mesh.
Its size corresponds to that of the visible points.
If a local axis system is set as current, the file will imported in this axis systems and not
in the absolute axis system as previously.
If no local axis system is set as current, the file will be imported in the absolute axis system.
Moreover, if a local axis system is set as current, the axis system of the dynamic box used to select
a portion of the imported file when the Update button is pushed is parallel to the local axis system axis.
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The check box Replace is used to replace the current cloud of points or mesh by a new one.

9. Once you are satisfied with the preview, click Apply and OK to finish the import of the cloud of points or mesh.

●

The name of the element created in the specification tree is the name of the original file, without its extension.

●

Undo and Redo are available.

●

V5 memorizes the data of the last imported file and proposes them at the next import action.

Importing a Set of Files
1. Click the Import icon

. The Cloud Import dialog box is displayed.

he operating mode is the same as for one file.
The files to import must:
❍
have the same format,
❍

be located under the same directory.
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The Selected File field looks like this:

❍

If you check the Grouped option (this is the default status):
All the files are imported as one single cloud of points instead of several:

The three digit files have been imported together, resulting in one cloud of points or mesh.
One cloud of points Element Cloud Import.x is created in the specification tree,
with the icon of the Import command.
❍

If you do not check the Grouped option: The files are imported separately.
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The three digit files have been imported separately, resulting in three clouds of points.
One cloud of points element is created in the specification for each input file,
with the icon of the Import command and the name of the input file
(MultiImport1.1, MultiImport2.1, MultiImport3.1)

●

You can also merge several clouds of points into one whenever necessary, using the Merge Clouds command.
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Exporting Clouds of Points
This chapter deals with the export of cloud of points to various formats.

You can export only one element at a time.

Exporting to ASCII keeping the Scans
Exporting to STL
Exporting to cgo
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Exporting Clouds of Points to ASCII files
This task shows how to export a cloud of points to ASCII, either as a cloud of points or as a set of
scans:
●
if the selection contains only a scan or a set of scans, they are exported as scans,
●

if the selection contains only a cloud of points, it is exported as a cloud of points,

●

if the selection contains both, the scans are exported.

Other formats available are:
●

STL,

●

cgo.

Open the ExportScan1.CATPart model the from the samples directory.
This model is made of two elements:
a cloud of points (Cloud Import.1) and a set of scans grouped into one element (Planar Sections.1).
1. Click the Scans element and then the Export icon

. The export dialog box is displayed.

2. In the Save as type field, select the requested format : Ascii free.
3. Browse your directories and enter the target directory and file name. Then click Save.

Digitized Shape Editor
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4. You can then use the Import action to recall the file you have created.

●

●

The selection is exported with the current local axis system if any, with the absolute axis system
otherwise.
The scans exported have the following delimiters: G08 for the start and G09 for the end.

You can export only one element at a time.
Therefore, if you want to export several scans, you must use the Grouped into one element option
when you create them.
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Exporting Polygons to STL
This task shows how to export a mesh to binary Stl format.
Other formats available are:
●

ASCII,

●

cgo.

Open the Cloud.CATPart from the samples directory.

1. Select the Polygon.1 and then the export icon

.

The export dialog box is displayed.

2. One export format is available: Stl.
3. Browse your directories and enter the target directory and file name. Then click Save.

●

The selection is exported with the current local axis system if any, with the absolute axis system
otherwise.

●

You can export only one element at a time.

●

In STL Rapid Prototyping, only the Stl format is available.

Digitized Shape Editor
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Exporting Clouds of Points to cgo
This task shows how to export a cloud of points to cgo.
Other formats available are:
●

STL,

●

ASCII.

Select the Cloud.CATPart file from the samples directory.

1. Select the Cloud element and then the Export icon

. The export dialog box is displayed.

2. In the Save as type field, select the requested format : Cgo.
3. Browse your directories and enter the target directory and file name. Then click Save.

4. You can then use the Import action to recall the file you have created.

●

The selection is exported with the current local axis system if any, with the absolute axis system
otherwise.

Digitized Shape Editor

You can export only one element at a time.
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Editing Cloud of Points
This chapter deals with the edition of clouds of points, i.e. Selection and Remove actions.
Although the dialog boxes look similar, the operating mode of the Select and Remove actions are
slightly different:
●
De-activated points can be recalled using Activate all and Swap in a new activation action.
●

●

●

●

●

Removed points can not be recalled! Activate all and Swap apply only to the current removal
action. They can not be used to recall removed points, once you have clicked OK.
The Activate Areas action displays only triangles that are fully selected (i.e. the whole triangle is
inside the selection trap, or all its vertices have been picked). If you select only one or two vertices
of a triangle, or if the selection trap intersects the triangle, it is not displayed.
As a consequence, when you push the button Swap, the triangles displayed are not the exact
complement of the previous selection.
The Remove action takes into account triangles that are at least partially selected (at least one
vertex has been picked, or the selection trap intersects the triangle).
See the Protect command to protect characteristic lines from deletion.

Activating a Portion of a Cloud
Filtering by Sphere
Remove
Adaptive Filtering
Protecting Characteristic Lines
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Activating a Portion of a Cloud of Points
This task shows how to select a portion of a cloud of points or of mesh in order to create a work area,
either:
●
by picking directly elements of the cloud (points, scans, grids, cells, clouds) or
●

by defining a portion of the cloud or mesh with a 2D or 3D trap,

●

by moving a brush over a portion of a mesh.

The free edges displayed are those of the complete mesh:
●
if you activate only a portion of a mesh, the free edges of that portion are not displayed.

Open the Cloud.CATPart model the from the samples directory.
Click here for more information on the dialog box.
1. Click the Activate Areas icon

and the mesh. The Activate dialog box is displayed.

Digitized Shape Editor
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2. Draw a rectangle by dragging the mouse over the portion you want to select.
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As you release the mouse, the triangles selected are highlighted in red.
When you move the mouse over one corner of the rectangle, dimensioning arrows are displayed,
enabling you to resize the rectangle.

3. Push the Valid Trap button that is now available and draw a second rectangle. Push Valid Trap
again.

Digitized Shape Editor
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4. Push the Swap button. The selection is inverted.
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5. Click OK to validate and exit the action.
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Filtering by Sphere
Filtering a cloud of points makes its manipulation easier.
This task shows how to filter a cloud of points homogeneously.
See the Protect command to protect characteristic lines.
Open the Cloud1.CATPart model the from the samples directory.

1. Click the Filter icon

and the cloud of points.

2. The filtering dialog box is displayed.
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2. Select the filtering type Homogeneous.
The filtering sphere is visualized by a green sphere.
You can change its position by a simple mouse click.

Changing the sphere radius via the Homogeneous counter in the dialog box changes
the sphere dimension on the screen and the filtering percentage:
the sphere passes over the cloud of points, starting on the first point met.
All the points that are inside the sphere are then hidden.
The sphere goes to the next remaining point and removes the points that it contains, and so on.

Step: 0
Points to be filtered: 14335
Remaining points: 14335 (100.00%)

Digitized Shape Editor
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Step: 1
Homogeneous
Radius : 4.78
Remaining points: 986 (6.88%)

Step: 2
Homogeneous
Radius : 9.56
Remaining points: 284 (1.98%)

The sphere value is displayed in the current unit (You can enter the value in another unit,
but it will be recomputed and displayed in the current unit).
●
To avoid memory problems, do not enter too low a radius value.
●

The sphere radius should not be smaller than the digitizing step.
3. Each time you click Apply, the computation is restarted on the whole cloud of points.
The display of the cloud of points and the statistics are updated.

4. Check the Physical removal option to delete the filtered points, thus optimizing the memory
requirements.

Digitized Shape Editor
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5. Push the Reset button to retrieve all the filtered points, i.e. points hidden in the present filtering
action
or in previous filtering actions, provided you did not use the Physical removal option.

6. Once you are satisfied with the result, click OK to confirm and exit the action.

●

The points are hidden, not removed, unless you use the Physical removal option.

●

Within a filtering action, Undo cancels the last filter action performed.

●

Leaving the action with Close restores the cloud as it was before starting the filtering action.

●

It is not possible to filter a meshed cloud of points.

●

●

When you filter scans or grids, you actually filter points: filtered points are hidden, and new scans or
grids are created.
Points that have been physically removed can not be retrieved.
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Removing Elements

This task shows you how to remove a elements from a cloud or a mesh.
●

●

●

●

●

●

The deleted elements are those that appear in red during selection.
By default, the trap is displayed in the view plane (2D trap).
You can rotate the model to display the trap as a 3D trap.
Within one removal action, use Activate all to recall all the points of the original cloud of points,
or Swap to invert the selection (the complement of the current selection becomes active
whereas the current selection is hidden).
The Remove action takes into account triangles that are at least partially selected
(at least one vertex has been picked, or the selection trap intersects the triangle).
Undo/Redo are not available on the global action.
Although the dialog boxes look similar, the operation mode of the Activate and the
Remove actions are slightly different:

●

●

●

Removed elements can not be recalled !
Activate all and Swap apply only to the current removal action.
They can not be used to recall removed elements once you have validated the action.
All free edges may be displayed.

Open the Cloud.CATPart model from the samples directory.
Click here for more information on the dialog box.

1. Click the Remove icon

and the mesh. The Remove dialog box is displayed.

2. Check the Mode option:
❍

Pick:
■
Select the required element type (Level) to remove elements using the hierarchical selection.
According to your choice and the application you are working in, only points, or triangles,
or scan/grid, or cells (sub-cloud) or clouds (global cloud) will be removed.
■

Select the unwanted elements on the cloud, then Click OK to confirm their removal and close the dialog box.
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Trap
■

Select the required Trap Type and the portion of cloud to remove (Inside or Outside Trap) to
remove elements using a graphical trap.

■

You can draw either one single trap, or several traps.

In that case, valid each trap with the Valid Trap push button before drawing the next one.
If you draw a trap, push Valid Trap, then Swap, you will remove the complement of the original selection.

■

Click OK when all traps have been defined to remove the unwanted elements and close the dialog box.

The traps may be either
❍
rectangular :
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In that case, you can modify the trap using the green manipulators.

❍

or polygonal :

❍

or spline:

In those cases, you can modify the trap using the green manipulators or use the Undo action on each segment
of the trap as long as you have not double-clicked to end the polygonal trap.
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Adaptive Filtering
Filtering a cloud of points makes its manipulation easier. This task shows how to hide points on planar
elements.
See the Protect command to protect characteristic lines.
Open the Adaptative1.CATPart model the from the samples directory.

1. Click the Filter icon

and the cloud of points.

2. The filtering dialog box is displayed.

3. Select the Adaptive filtering type. The value to enter represents the local chordal deviation.
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This filtering hides more points from the planar areas than from other areas.
That way, you can highlight bent areas.
Step: 0
Points to be filtered: 114250
Remaining points: 114250 (100.00%)

Step: 1
Adaptative
Chord : 0.02
Remaining points: 7529 (6.59%)

You can note that the free boundaries have not been respected.
This may lead to inaccurate outputs in downstream operations such as meshings.
To avoid this problem, check the Max. Distance button and leave it to 3mm.
This will ensure that a maximum distance of 3mm is kept between the remaining points,
thus preserving the shape of the part.
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Step: 3
Adaptative with max. distance
Chord: 0.02 Max. Distance: 3
Remaining points: 7940 (6.95%)

The chordal deviation is displayed in the current unit
(You can enter the value in another unit, but it will be recomputed and displayed in the current unit).
4. Each time you click Apply, the computation is restarted on the whole cloud of points.
The display of the cloud of points and the statistics are updated.

5. Check the Physical removal option to delete the filtered points, thus optimizing the memory
requirements.

6. Push the Reset button to retrieve all the filtered points, i.e. points hidden in the present filtering
action
or in previous filtering actions, provided you did not use the Physical removal option.

7. Once you are satisfied with the result, click OK to confirm and exit the action.

●

The points are hidden, not removed, unless you use the Physical removal option.

●

Within a filtering action, Undo cancels the last filter action performed.

●

Leaving the action with Close restores the cloud as it was before starting the filtering action.

Digitized Shape Editor
●

●

●
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It is not possible to filter a meshed cloud of points or a mesh.
When you filter scans or grids, you actually filter points: filtered points are hidden,
and new scans or grids are created.
Points that have been physically removed can not be retrieved.
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Protecting Characteristic Lines
This task shows how to protect characteristic lines from filtering and removal.
One standard scenario is:
●

import of a cloud of points,

●

import or creation of characteristic lines (e.g. scans)

●

union of the cloud of points and the scans

●

●

filtering of the union cloud.
At this stage, it is interesting to keep the characteristic lines untouched,
because they are more pertinent than other points of the cloud,
and because they will produce sharp edges of a better quality at the mesh creation step
meshing of the union cloud.

Open the Protect1.CATPart model the from the samples directory.

1. Click the Protect icon

and the cloud of points.

2. The Protect cells dialog box is displayed. The characteristic lines are recognized.
By default, they are labeled Unprotected.
3. Select the kind of entities you want to work on: Cell or Scan/Grid.
4. Place the cursor on the label and right-click to go the contextual menu.

Page 65

Digitized Shape Editor

Version 5 Release 16

Page 66

You can change the status of one single scan to Protected or Unprotected,
or Protect all scans or Unprotect all scans (or Protect all cells or Unptrotect all cells according to
the type of cloud).
You can also click on each label to change it to the required status.
5. Click OK to confirm your choice and exit the action, or Cancel to revert to the initial state and exit
the action
6. When you enter the Remove or the Filter commands, the protected cells or scans are shown
as low-intensity elements (meaning they can not be filtered nor removed) and
are not taken into account by the command.

Digitized Shape Editor
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Aligning Clouds
Aligning using the Compass
Aligning Clouds with Constraints
Aligning Clouds using Spheres
Aligning a Cloud with a Cloud
Aligning a Cloud with Surfaces
Aligning a Cloud with Points
Use Align Transformation
Tips to align Clouds
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Aligning using the Compass
This task will show you how to align clouds of points using the compass.
This "rough" alignment offers:
●

a manual alignment using the compass,

●

a better control of the initial move when aligning inertia axes.

It can thus be considered as a pre-processor for the "best fit alignment" actions.
See the glossary for the definition of cloud to align, reference, constraint and constraint element.
Open the Reposition1.CATPart model the from the samples directory.

1. Click the Align using the Compass

icon.

2. The Alignment with Compass dialog box is displayed.
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3. Select the cloud to align.

4. Select the reference and click OK
or click OK without selecting a reference.

Selecting the reference starts the computation of a transformation based on the inertia axes.
f you click OK without selecting the reference, this transformation is not computed, therefore it will not
be available.
5. For better display performances, the following display modes are available:

❍

Shading or Triangles for meshes (check the required option),

❍

Points for clouds of points. Use the slider to select the percentage of points to be displayed.

Selective Display is available at any time.
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6. The Move icons are now available:
Active only if you have selected a reference. Offers an alignment by inertia axes.
There are 4 possible solutions. Push the icon repeatedly to visualize them successively.

Places the compass on the gravity center of the cloud to align.
Move the compass as you want to position the cloud.

Reverts to the last move validated by Apply.

7. Validate a move by Apply.
You can them initiate another move if necessary, or validate the alignment by OK and exit the
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dialog box.

In the compass mode (
origin.

), by default you move the cloud with the gravity center of the cloud as the

However, you may want to take another point as the origin of the move, e.g. to perform a rotation.
To do so, drag the compass while pressing the Shift key and drop it to the point you want to take as the
origin.
Then perform the move as usual.
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8. Once you are satisfied with the alignment computed, click OK to validate and exit the action.
A new cloud is created on the reference, the cloud to align is still visible.
The new cloud is created in the specification tree, as well as an Axis Systems containing:
❍

AxisRef.x (system axis computed on the cloud to align) and

❍

AxisTrs.x (axis system created on the output cloud).

Those Axis Systems can be used with the Axis to Axis action on other elements to align.
Align with previous transformation is also available.
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Aligning Clouds with Constraints
This task shows you how to align a cloud of points with a reference by defining constraints
(made of pairs of constraint elements) based on canonic shapes
(points, lines, planes, spheres, cylinders, circles and their inverted elements)
and applying a priority order on those constraints.

See the glossary for the definition of cloud to align, reference, constraint and constraint element.
This operation is useful with mechanical shapes, where canonic shapes can be defined.
When such shapes can be used, this kind of alignment is quicker than the other types
(Align with Cloud, with Surface, with Points, with Spheres) proposed by V5.
You need to recognize canonic shapes
●

●

on the cloud to align (Quick Surface Reconstruction offers a Basic Surface Recognition action),
then on the reference (by extracting faces or creating points, lines and planes representing fixed
constraints).

These canonic shapes are not necessarily the same (any association of points/lines/planes is possible).
Then match the canonic shapes by pair, one on the cloud to align, the other on the reference.
It is possible to match one constraint element of the cloud to align with several constraint elements
(whatever their type) of the reference, or vice versa
(a plane can be matched with three different points in three different constraints, for example).
Be careful to have consistent constraints, regarding the geometry. For example:
●

do not match three points with two different planes,

●

if you match two normals to planes, be careful that they have the same orientation,

●

●

●

when you select a cylinder or a circle, the constraint element taken into account is their center axis,
i.e. a line.
when you select a sphere, the constraint element taken into account is its center point.
even if overconstraints are accepted, in some cases it might be necessary that the constraints form an
isostatic system:
A 3D object has 6 degrees of freedom, i.e. 3 translations and 3 rotations.
Creating an isostatic system means that the 3 translations and the 3 rotations are locked.
Here are the degrees of freedom locked by each pair of constraints:
point

point

line

3 translations 2 translations

plane

1 translation
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1 translation and 1 rotation
line

2 translations 2 translations and 2 rotations

plane 1 translation

1 translation and 1 rotation

1 translation and 2 rotations

In a general case, you should combine the constraints to lock all the degrees of freedom.
Open the AlignConstraint1.CATPart model from the samples directory.
It consists of one cloud to align, a set of constraint elements computed on the cloud to align,
a set of constraint elements on reference.
1. Define New as the In Work Object.
2. Click the Align with Constraints icon

.

3. The Alignment with Constraints dialog box is displayed.
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4. Select the CloudToMove as the cloud to align.
Selective display can be activated and/or de-activated at any time to hide the cloud
and make selection of the constraints easier.
Once the cloud to align is selected, the button Add becomes available.

5. Click Add.
Select the large cylinder recognized on the cloud to align, then the large cylinder on the
reference.
6. Repeat step 4. with the small cylinder, and once again with the sphere.

The colors of the constraint elements picked change:
❍

A color is associated to each couple of constraint elements that define a constraint.

❍

The constraint element selected on the cloud to align is displayed in a solid color,

❍

The constraint element selected on the reference is displayed in a transparent color,

❍

Another color is associated to the next couple of constraint elements, etc

●

Always pick a constraint element on the cloud to align, then one constraint element on the reference.

●

You must define at least one constraint.

Digitized Shape Editor
●
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The orientation of lines or axes selected on the cloud to align can be set automatically or
manually using the Orientation options Automatic or Manual.

●

●

●

●

when Automatic is selected,
the orientation of the constraint element is not displayed and is automatically optimized.
when Manual is selected,
the orientation of the constraint element is represented by a red arrow.
It can be inverted by clicking the arrow.
The Automatic option may be more time consuming.
This functionality is not available for constraint elements on the reference.
If you need to invert the orientation of constraint elements on the reference,
you can use the Invert Orientation command.

7. The constraints created are listed in the dialog box.

❍

Clear All deletes all the constraints.

❍

Delete deletes the constraint selected.

❍

Add adds new constraints.

❍

In the In Cloud to Align column, you see which element has been picked on the cloud to
align.

❍

In the In Reference column, you see which element has been picked on the reference.

❍

In the Priority column, you see which kind of priority is applied to this constraint.
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8. Select the line with CylinderS1.2 and right-click. Select Strict from the contextual menu.
This contextual menu displays the priorities that can be applied on each constraint,
from the highest priority (Strict) to the lowest (Low).

The dialog box is updated accordingly.

9. Click Apply and press More.
❍

The Statistics windows appears.
Alignment #1 indicates this is the first computation you have launched since you have
opened the dialog box,
For each constraint (e.g. Constraint #1) is given:
■
the type of the constraint and the constraint element selected type: line (CylinderS1.2)
/ line (CylinderT1.1).
■

■

❍

the priority applied to this constraint (Strict),
the distance (dist.=0) and the angle (angl.=0) between the constraint element on the
cloud to align
and the constraint element on the reference.

You can see that the constraint with a strict priority is fully respected.

Digitized Shape Editor
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●

●
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You can easily retrieve the history of the computations and revert to a given combination of
constraints
before creating the aligned model.
You will find the distance gaps for constraints of the types point/point, point/line, point/plane,
line/line,
line/plane and plane/plane, as well as the angular gaps for constraints of the types line/line, line/plane
and plane/plane.
Since those gaps are computed from the infinite support of lines and planes that make the constraints,
the distance between two non parallel planes (or a line and a plane) will be null.
Only significant gaps between a line and a plane or between two planes will be displayed
(i.e. only when the two constraint elements are parallel).
The Statistics are given for the constraint elements, they do not refer to the real gaps between
the cloud to align and the reference. Those gaps are given by the Distance Analysis.
A constraint with a Strict priority is not fully respected when the distance is greater than 0.001 or
the angle is greater than 0.5. This may happen when a constraint with a Strict priority is applied
simultaneously
to other constraints. A message warns you that the constraint could not be fully respected.
If the constraints are not consistent, an information message is displayed.
You can then decide whether the result is satisfactory or not.
10. Once you are satisfied with the alignment computed, click OK to validate and exit the action.
A new cloud is created on the reference, the cloud to align is still visible.
The new cloud is created in the specification tree,

as well as an Axis Systems containing:
❍
AxisRef.x (system axis computed on the cloud to align) and
❍

AxisTrs.x (axis system created on the output cloud).
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Those Axis Systems can be used with the Axis to Axis action on other elements to align.
Align with previous transformation is also available.
When the alignment cannot be computed, an information message is displayed (Update error). You can :
●
delete constraints
●

delete and add other constraints

●

check the consistency of the constraints

●

eventually, re-compute the basic shapes used.

The method we suggest is:
1. Exit the action,
2. Restart the alignment with one single constraint,
3. Click Apply.
4. If the computation is still impossible, restart the alignment with another constraint.
5. If the computation is possible, add another constraint and repeat the process from step 3 in loops
until the result is satisfactory.

If constraints are deleted, the intermediate computation is erased.
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Aligning Clouds using Spheres
This task shows you how to align clouds of points (clouds to align) to other clouds of points (reference),
using sphere recognition.
See the glossary for the definition of cloud to align, reference, constraint and constraint element.
Open the Reposition1.CATPart model the from the samples directory.
It consists of two clouds of points with three spherical tags on each.
These tags have been created during digitizing in order to align the two clouds in future operations.
1. Click the Align using Spheres icon

. The Alignment dialog box is displayed.

2. Pick the cloud to align
(in fact the output cloud is a moved copy of the cloud to align, which can then be hidden if
necessary),
then the reference.
3. Then pick the spheres on the cloud to align, click OK to validate them.
If you know the radius of the spheres, check the Constrained check box and enter the radius in
the input field.
Digitized Shape Editor will compute the spheres with that radius.
If you do not know the radius of the spheres, click the first sphere.
Digitized Shape Editor will compute this radius and update the input field accordingly.
Then you may check the Constrained box and select other spheres that will have the same
radius.
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Use the Selective Display option to make the definition of the spheres
easier:
when this option is active, only the cloud where you should define the
spheres is displayed.
Once you are finished with the cloud to align, it is hidden and the reference
is displayed.

4. Repeat the sphere selection step on the reference, click OK to validate them.
The cloud to align is duplicated and this copy is moved towards the target.
This new cloud appears in the specification tree. It has the name of the cloud to align, with its
index increased by one.
An element Axis_Systems is also created in the specification tree,
that contains the axis system computed on the cloud to align and the axis system computed on
the output.
These two axis systems can be used in an Axis to Axis transformation with other geometrical
elements (i.e. replay the alignment).

●

●

●

●

While aligning clouds, you can use the function Distance analysis to check the output accuracy.
The target will be the output cloud. Since a new output cloud is generated at each alignment,
you should repeat the distance analysis with each new output cloud.
We recommend that you pick the sphere in a direction orthogonal to the part to process,
i.e. along the green axis and not along the black axis in our example:

For an easier sphere recognition, we recommend that you pick in the middle of the sphere, not at the
edge.
If you use 3 spheres, they should not form a isosceles nor an equilateral triangle
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(the system could not find out the right solution between the two or six possible solutions).
●

The result entity has the same structure as the input entity: scans, grids or meshes.

●

Undo is available on the selection of spheres.
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Aligning Clouds
This task shows you how to align a cloud of points (cloud to align) with another cloud of points (reference).
If you want to align a cloud of points with points, use the Align with Points action.
Open the Reposition1.CATPart model from the samples directory.
It consists of two clouds of points with three spherical tags on each.
These tags have been created during digitizing in order to align the two clouds in future operations.
1. Click the Align with Cloud icon

❍

❍

❍

. A selection dialog box is displayed.

To activate an area by picking elements,
select them and click OK to confirm the activation and close the dialog box.
To create a single activation area by trap, draw the trap, modify it when necessary and
click OK to confirm the activation and close the dialog box.
To create several activation areas by traps, draw the first trap, modify it when necessary,
click Valid Trap to validate this trap.
Repeat these steps for each trap then click OK to confirm the activation and close the dialog box.

2. Select first the cloud to align (in fact the output cloud is a moved copy of the cloud to align,
which can then be hidden if necessary).
3. Then select the reference.

4. Define significant common areas on each cloud (cloud to align and reference) using the Alignment dialog box
(its operating mode is the same as Activating a Portion of Cloud):
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❍

Draw a selection trap on the cloud to align,

❍

Click Valid Trap,

❍

Repeat those two steps to define the next areas,

❍

Click OK when all areas have been defined on the cloud to align,

❍

Repeat the steps above on the reference.

These areas are the basis of the computation. They may have any shape, be in any number.
In our example, the significant areas are the circular tags.
As long as you have not double-clicked to end the polygonal or spline trap,
you can undo/redo each pick of the polygonal trap.

5. Use the Selective Display option to make the definition of the computation areas easier:
when this option is active, only the cloud where you should define computation areas is displayed.
Once you are finished with the cloud to align, it is hidden and the reference is displayed.

6. After the last OK, Digitized Shape Editor proposes to compute the first move:

❍

Answer Yes: Digitized Shape Editor aligns the center of gravity and the inertia axes of the parts,
then the position of each part.

❍

Answer No: Digitized Shape Editor aligns only the position of each part.
This is recommended when the alignment of the parts is already almost correct.
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The cloud to align is duplicated and this copy is moved towards the reference.
This new cloud appears in the specification tree. It has the name of the cloud to align,
with its index increased by one.
An element Axis_Systems is also created in the specification tree, that contains the axis system computed
on the cloud to align and the axis system computed on the output cloud.
These two axis systems can be used in an Axis to Axis transformation with other geometrical elements
(i.e. replay the alignment).
Statistics on the alignment operation are available.

7. Push the More button.
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The Statistics are displayed as soon as the computation is started.
This is the first section displayed. It indicates:
❍
the type of alignment performed (here it is a best fit
registration),
❍

❍

the number of points found in the mobile cloud, i.e. the cloud
to align,
the number of points found in the reference, i.e. the reference.

This section is displayed when the computation is done. It
indicates:
❍
the number of iterations done,
❍

❍

❍

❍

the maximum deviation found between the points of the cloud
to align and the reference,
the mean deviation found between the points of the cloud
to align and the reference. This deviation should be as small as
possible.
the standard deviation, i.e. the dispersion of the points around
the mean deviation.
A small standard deviation indicates that most points are within
the mean deviation,
i.e. that there are only few outliers.
the percentage of points of the cloud to align that are below
the mean deviation.

You can select the text and copy it to a word or data processing software.
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●

You can repeat the process to improve the alignment, but this time, do not accept the automatic first move.

●

The cloud to align should not contain a large amount of points,

●

The shape of the traps on each cloud should be similar and contain coincident points

●

The trap(s) on the reference should contain more points and be larger than the trap(s) of the cloud to align.

●

●
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You can use the function Distance analysis to check the output accuracy. The target will be the output cloud.
Since a new output cloud is generated at each alignment, you should repeat the distance analysis with each new output cloud.
The result entity has the same structure as the initial entity: scans, grids or meshes.
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Aligning a Cloud with a Surface
This task shows you how to align a cloud of points with surfaces.
See the glossary for the definition of cloud to align, reference, constraint and constraint element.
Open the Reposition2.CATPart model from the samples directory.

1. Click the Align with Surface

icon. A selection dialog box is displayed.

2. Pick the cloud to align, and the reference surface(s).
Push the Valid Surfaces to end the selection of the surface(s).

Digitized Shape Editor

Version 5 Release 16

Page 89

Surfaces can be selected:
❍

by picking them in the geometry,

❍

by picking them in the specification tree,

❍

by using bounding outline or the standard selection traps.

The reference surface:
❍

can be a join.

❍

can also be a plane.

❍

There is no limit to the number of reference surfaces.

3. The Valid Geometry button has turned to Valid Trap.
4. Define significant areas on the cloud to align using the Alignment dialog box
(its operating mode is the same as Activating a Portion of Cloud).
❍

❍

❍

❍

To activate an area by picking elements, select them and click OK.
To create a single activation area by trap, draw the trap, modify it when necessary
and click Valid Trap, then OK.
To create several activation areas by traps, draw the first trap, modify it when necessary,
click Valid Trap to validate this trap. Repeat these steps for each trap
then click OK to confirm the activation and close the dialog box.
Selective Display is not available with this action.

5. Click Valid Trap between each area definition.
These areas are the basis of the computation. They may have any shape, be in any number.
In this case, the significant areas are the circular tags.
6. Click OK when all areas have been defined.
Digitized Shape Editor proposes to compute the first move:

Digitized Shape Editor

❍
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Answer Yes: Digitized Shape Editor aligns the center of gravity
and the inertia axes of the parts, then the position of each part.

❍

Answer No: Digitized Shape Editor aligns only the position of each part.
This is recommended when the alignment of the parts is already almost correct.

7. The cloud is repositioned on the surface(s):
The output cloud is a moved copy of the cloud to align, which can then be hidden if necessary.
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The cloud to align is duplicated and this copy is moved towards the reference.
This new cloud appears in the specification tree.
It has the name of the cloud to align, with its index increased by one.
An element Axis_Systems is also created in the specification tree,
that contains the axis system computed on the cloud to align and
the axis system computed on the output.
These two axis systems can be used in an Axis to Axis transformation
with other geometrical elements
(i.e. replay the alignment).
Statistics on the alignment operation are available.
7. Push the More button.
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The Statistics are displayed as soon as
the computation is started.

This is the first section displayed. It
indicates:
❍
the type of alignment performed
(here it is a best fit registration),
❍

❍

the number of points found in the
cloud to align,
the number of surfaces making the
reference, i.e. the target.

This section is displayed when the
computation is done.
It indicates:
❍
the number of iterations done,
❍

❍

❍

❍

the maximum deviation found between
the points
of the cloud to align and the
referencesurfaces,
the mean deviation found between the
points of
the cloud to align and the
referencesurface.
This deviation should be as small as
possible.
the standard deviation, i.e. the
dispersion of the points
around the mean deviation.
A small standard deviation indicates
that most points are
within the mean deviation, i.e. that
there are only few outliers.
the percentage of points of the cloud to
align that are
below the mean deviation.

You can select the text and copy it to a word or data processing software.

Digitized Shape Editor
●

●

●

●

●

●
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No need to define a computation area on the surface(s).
As long as you have not double-clicked to end the polygonal or spline trap,
you can undo/redo each pick of the polygonal trap.
You can use the function Distance analysis to check the output accuracy.
The target will be the output cloud.
Since a new output cloud is generated at each alignment, you should repeat the distance analysis with
each new output cloud.
The result entity has the same structure as the input entity: scans, grids or meshes.
You can repeat the process to improve the alignment, but this time, do not accept the automatic first
move.
The cloud to align should not contain a large amount of points.
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Aligning a Cloud with Points
This task shows you how to align a cloud of points with CATIA points.
If you want to align a cloud of points with another cloud of points, use the Align with Cloud action.
Open the Reposition2.CATPart model from the samples directory.

1. Click the Align with Points

icon. A selection dialog box is displayed.

2. Pick the cloud to align, and the reference points (at least 3).
Push the Valid button to end the selection of the points.
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Points can be selected:
❍

by picking them in the geometry,

❍

by picking them in the specification tree,

❍

by using bounding outline or the standard selection traps.

3. The Valid Geometry button has turned to Valid Trap.
4. Define significant areas on the cloud to align using the Alignment dialog box
(its operating mode is the same as Activating a Portion of Cloud):
❍

❍

❍

❍

To activate an area by picking elements, select them and click OK.
To create a single activation area by trap, draw the trap, modify it when necessary and
click Valid Trap, then OK.
To create several activation areas by traps, draw the first trap, modify it when necessary,
click Valid Trap to validate this trap. Repeat these steps for each trap
then click OK to confirm the activation and close the dialog box.
Selective Display is not available with this action.

5. Click Valid Trap between each area definition.
These areas are the basis of the computation. They may have any shape, be in any number.
6. Click OK when all areas have been defined. Digitized Shape Editor proposes to compute the first
move:

❍

Answer Yes: Digitized Shape Editor aligns the center of gravity
and the inertia axes of the parts, then the position of each part.

❍

Answer No: Digitized Shape Editor aligns only the position of each part.
This is recommended when the alignment of the parts is already almost correct.
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7. The cloud is repositioned on the points:
The output cloud is a moved copy of the cloud to align, which can then be hidden if necessary.

Digitized Shape Editor
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The initial cloud is duplicated and this copy is moved towards the reference.
This new cloud appears in the specification tree.
It has the name of the cloud to align, with its index increased by one.
An element Axis_Systems is also created in the specification tree,
that contains the axis system computed on the cloud to align and
the axis system computed on the output.
These two axis systems can be used in an Axis to Axis transformation with
other geometrical elements (i.e. replay the alignment).
Statistics on the alignment operation are available.

8. Push the More button.
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The Statistics are displayed as soon as the computation is started.
This is the first section displayed. It
indicates:
❍
the type of alignment performed
(here it is a best fit registration),
❍

❍

the number of points found in the
cloud to align,
the number of reference points.

This section is displayed when the
computation is done. It indicates:
❍
the number of iterations done,
❍

❍

❍

❍

❍

the maximum deviation found
between the points of the cloud
to align and the reference,
the mean deviation found between
the points of the cloud
to align and the reference points.
This deviation should be as small as
possible.
the standard deviation, i.e. the
dispersion of the points
around the mean deviation.
A small standard deviation indicates
that most points are within
the mean deviation, i.e. that there
are only few outliers.
the computed deviations, that is the
number of points of the
cloud to align used to compute the
move, i.e. the number of
points of the cloud to align
that have an orthogonal projection on
the reference.
the percentage of points of the cloud
to align
that are below the mean deviation.

A small mean deviation means that the cloud to align moved almost to the right position.
You can select the text and copy it to a word or data processing software.
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●

The Selective Display option is not available.

●

No need to define a computation area on the points.

●

●

●

●

●
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As long as you have not double-clicked to end the polygonal or spline trap,
you can undo/redo each pick of the polygonal trap.
You can use the function Distance analysis to check the output accuracy.
The target will be the output cloud.
Since a new output cloud is generated at each alignment, you should repeat the distance analysis
with each new output cloud.
The result entity has the same structure as the input entity: scans, grids or meshes.
You can repeat the process to improve the alignment, but this time, do not accept the automatic first
move.
The cloud to align should not contain a large amount of points.
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Use Align Transformation
This task shows you how to re-use a transformation already computed for a previous alignment of clouds
(cloud to cloud, cloud to surface, clouds using spheres, ...).
Open the Reposition1.CATPart model from the samples directory. Perform any kind of alignment.

1. Click the Align with Previous Transformation icon

.

2. Select the cloud to align.
Digitized Shape Editor applies the computation used by the last alignment action to
the selected cloud and previews the moved cloud.
Then a message is displayed, asking you to confirm this move.
3. Click Yes to validate or No to abort the alignment action.

The cloud to align is duplicated and this copy is moved towards the target.
This new cloud appears in the specification tree. It has the name of the cloud to align, with its
index increased by one.

Only the very last alignment action is available for re-use.
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Tips to align Clouds
This chapter lists a few tips to align a cloud with another cloud, or a cloud with surfaces.
These recommendations apply to clouds or to a cloud and surfaces that have similar shapes,
where the cloud to align will cover the reference cloud or the reference surfaces.
●

Do not modify the reference (cloud or surfaces).

●

To reduce the computation time, filter the cloud to align.
Use the homogeneous filtering (the repartition of points is more suitable),
and choose a filtering value that leaves only a few thousand points.

●

You can either:
❍

Select the whole cloud to align, and the whole reference (cloud or surfaces).

❍

or portions of the cloud and only some surfaces of a model.
In this case, be careful that the selected areas/surfaces have similar shapes.

●

Accept to align inertia axes.

This first step may take a few minutes.
1. Check whether the cloud has been aligned correctly.
2. Depending on what you see:

❍

If the result is not correct,
■

Undo the alignment and start again.

■

This time, try to select a characteristic portion of the cloud to align, and its counterpart on
the reference:
for instance, if the shape is symmetrical, select a portion that is not.

■

❍

Once again, accept to align inertia axes.

If the result is correct,
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■

Hide the cloud to align and unfilter the output cloud.

■

Select the whole output cloud and the reference,

■

Launch the computation, but this time do not accept to align inertia axes.

■

Repeat this step if necessary.

■

If the cloud to align is large, you can filter it, but keep more points than for the first step.

3. Now, the result seems correct:
❍

Use the Distance Analysis for the last controls.
■

The first set is the cloud to align, the second set is the reference cloud or the surfaces.

■

Set the Discretization at 100, uncheck Min/Max Values, Points and Spikes.

■

Use the Limited color range with the values you require.

■

Faulty areas will appear in red, correct areas in green.

4. To remove faulty areas:
❍

Select the areas in red, and some areas in green, and launch another computation.

❍

The areas in green will act as a fastener, while the areas in red will be improved.

Altogether, aligning a cloud with another cloud or surface should require 3 or 4 iterations.
If the result is not yet satisfactory after 4 iterations, you probably will not be able to improve it.
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Meshes
This chapter deals with the meshing of clouds of points.
Mesh Creation
Offsetting a Mesh
Rough Offset
Flip Edges
Smoothing Meshes
Mesh Cleaner
Fill Holes
Interactive Triangle Creation
Decimating Meshes
Optimizing Meshes
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Mesh Creation

This task shows how to mesh a cloud of points or regenerate an existing mesh.
The Mesh Creation and the Mesh Regeneration actions offer:
●

a neighborhood parameter that makes it possible to fill holes or to let some areas unmeshed,

●

an automatic detection or a manual definition of the meshing plane for the 2D mesher,

●

boundary continuity with contiguous meshes through the Constrained option,

●

●

a fully automatic 3D meshing (c)INRIA, suitable for mechanical parts
with blind or through holes, that respects details, especially sharp edges,
a sag value to mesh dense clouds with a reduced number of triangles,
but still respecting the 3D Shape within a given tolerance.

In STL Rapid Prototyping, Mesh Regeneration is allowed on meshes only,
i.e. objects whose partially or totally active cells are meshes.
If this is not the case, a fatal error panel is displayed:
Mesh Regeneration is allowed on meshes only.
Open the Cloud.CATPart model from the samples directory.

1. Click the Mesh Creation or Mesh Regeneration icon

.

The Mesh Creation dialog box is displayed.
2. Check the Execution Mode option you need:
❍

3D Mesher this is a meshing method for complicated shapes
(e.g. mechanical objects, clouds that can not be projected onto a single plane,
or without draft characteristics).
This is the default option.

Digitized Shape Editor
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This mesher provides a Sag option to reduce the number of triangles computed on dense clouds.
However, this option respects the shape of the object.
You would achieve the same result by filtering the cloud with the adaptative option set
to the sag value and meshing the output.
You can also mesh a cloud with a sag equal to 0. This means that all the points are meshed.
This algorithm is more suitable to mesh large clouds quickly.

❍

2D Mesher: this is a less complex meshing method, to apply to simple objects, i.e.
that can be projected onto a single plane (smooth shapes).
The entry dialog box is replaced with that of the 2D Mesher.
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2. If you have selected the 3D Mesher, if necessary check the sag option and enter its value,
or keep the default 3D Mesher.
3. If you have selected the 2D Mesher, select the plane that is the computation reference for the meshing:

❍

either one main plane

❍

or one defined with the compass

The quality of the mesh depends on the computation direction.

4. A Neighborhood value is proposed in accordance with the model.
This value represents the maximal edge length of the triangles displayed.
The value proposed is just an approximation of this value.
Its relevance depends on the distribution of the points in the cloud.
It is visualized by a sphere. You can change its position by a simple mouse click.

The sphere is updated when you change the Neighborhood value.
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5. Check the Display option you need:

●

●

Triangles to display only the mesh,
Shading to simulate the surface of the object:
❍
with the Flat option, the light is sent on the triangles along their normal,
❍

●

●

with the Smooth option, the light is smoothed over the triangles,
giving a better image of the quality of the surface.

Meshing requires a complex computation.
The computation time will increase according to the size and complexity of your model.
You may want to filter the cloud before starting the meshing.
To mesh large quantities of points, we recommend the following settings:
❍
Sag=0mm
❍

Triangles not activated

❍

Shading activated, with the Smooth option.

These display options are applied within this action only.
Once you have validated the result with OK, the result is displayed in the Smooth mode,
even if the input element or the computed mesh were displayed in another mode.
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6. Constrained is used to:

●

re-process a portion of a mesh by adding points to an existing mesh or
reprocessing a meshed cloud that has been unfiltered:
Open the Mesh2.CATPart model from the from the Samples directory.
The original mesh had holes in it. Select a faulty portion and proceed to a new meshing on that
portion.
The original mesh is in red. The re-processed mesh is in blue.

●

connect several meshes:
Open the Mesh1.CATPart model from the Samples directory. Draw two traps on that part and
mesh
them with different values, as shown below. Now activate the remaining square of points, as
shown below.

7. For quicker meshing performances, you can filter portions of the parts according to your successive
needs.
The mesh is unconstrained, the activation trap does not overlap the previous meshes.
The resulting mesh is independent from the other two.
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The mesh is constrained, the activation trap overlaps the previous meshes.
The resulting mesh is connected to the other two.
Facets of the existing mesh that were totally or partially inside the trap have been removed
and recomputed to adjust to the additional mesh.

8. Click Apply to check or update the result.
Then click OK to confirm the result and exit the action.
An element Mesh Creation.x is created in the specification tree.
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Increase the Neighborhood value to improve the mesh or reduce it to avoid filling holes that should remain
clear:
Triangles:

Shading:

Digitized Shape Editor
●

●

●

●

●
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In some cases, it may be difficult to find a Neighborhood value that will fill unwanted holes,
without creating unwanted triangles:

Seams may appear on the mesh with the Smooth option, :

●

They indicate that the normals to the facets have different directions at this place.

●

In 2D and 3D mode, some triangles may overlap and mesh should be corrected.

●

In Constrained mode, they show the common boundaries of meshes.

When computing a constrained mesh, enter 0 as the Neighborhood value to check the boundaries of the
mesh.
If the boundaries are not satisfactory, modify the mesh plane to improve them.
After the computation of a constrained mesh, two mesh elements are visible in the specification tree:
the constrained mesh and the initial mesh. You can select one and then the other to make sure they are
complementary.
You can use the Meshes Merge action to obtain a single mesh.
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Offsetting the Mesh

This task shows how to offset a meshed cloud of points.
Open the OffsetMesh1.CATPart model from the samples directory.

1. Click the Offset icon

. The Offset Mesh dialog box is displayed.

2. Select the mesh.
3. Enter an Offset value.
The offset mesh is displayed, together with a green vector representing the offset.
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4. Check the Create scans option if necessary, to create the free edges scans:

5. Click Apply to check or update the result. Then click OK to confirm the result and exit the action.
The element Offset Mesh.x is created in the specification tree.

●

In this release, a clipping problem may affect the bounding box of the offset mesh.

●

The offset is computed in the direction of the weighted normals of the points.

●

For better results, you should avoid to enter a high offset value.

Version 5 Release 16

Digitized Shape Editor

Page 114

Rough Offset
This task will show you how to create offsets from complex geometries,
that may contain either sharp or smooth features.
The offset mesh will present no self intersections, too small features being eliminated automatically.
The offset distance will be respected all along the mesh.
The mesh to process:
●
may not be non-manifold. You should use the Mesh Cleaner.
●

may have one hole at the most.

●

may be watertight or have one single boundary.

This action requires a Shape Sculptor license.
Open the RoughOffset1.CATPart from the samples directory

1. Click the Rough Offset icon

and select the mesh.

2. A white arrow symbolizes the Offset Distance and its direction (positive, negative, in both
directions)
as you set it.
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3. Set the Granularity that controls the coarseness of the offset mesh.
The smaller the value of Granularity, the higher the quality of the offset mesh.
With a high Granularity value:

With a low Granularity value:

Be aware that a small Granularity value will require more time and more memory
to compute the offset mesh.
In extreme cases, the computation may even be impossible.
You will then be requested to increase the Granularity value.
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4. Push one of the Direction icons to determine how the offset is carried out and click Apply:
In the pictures below, the original mesh has its containment box highlighted.
One side
With a positive Offset Distance:

With a negative Offset Distance:

One side extended
With a positive Offset Distance:

With a negative Offset Distance:

Both sides
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With a positive Offset Distance (a negative distance is not relevant):

5. Click OK to create the offset mesh. An Offset.x element is created in the specification tree.
Or click Cancel to exit the action without creating any mesh.
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Flip Edges

This task shows you how to flip edges of triangles of a mesh, for a better respect of sharp edges,
by rotating the triangles common edges without modifying their vertices.
The meshing may become less harmonious but will provide a better respect of the shape of the part
because the triangles will be oriented in the direction of the shape, in particular for sharp edge fillets.
This is particularly important for milling operations that may follow.
This action reorganizes the meshing without modifying the geometry because the vertices are not recomputed.
●

The new mesh inherits the graphic properties and display mode of the initial mesh.

●

During the process, the mesh is displayed in Flat Shading mode.

●

This action cannot be used on meshes with non-manifold edges.

●

Undo/Redo are available.

●

You may create several Flip_Edge.x elements in the specification tree,
corresponding to various degrees of reorganization of a given mesh.
You may then delete any of them, according to your needs.

Open the Flipedge.CATPart model the from the samples directory.

1. For a better view, set the View>Cloud Display Options to Flat.

2. Click the Flip Edges icon

and the mesh. The dialog box is displayed.
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2. Eventually, set the value of Depth, that determines the amplitude of the reorganization of the mesh:

❍

The value of Depth ranges from 0 to 10.

❍

The default value is 2.

❍

When the value of Depth is 0, the action processes a triangle and its direct neighbors.

❍

When the value of Depth is 1, the action processes a triangle, its direct neighbors and their direct
neighbors,
and so on as you increase the value of Depth.

❍

This may lead to a temporary degradation of the energy function of the mesh, but results in a final
optimal solution.

❍

The computation time depends on the value of Depth, and on the size of the mesh to process.
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3. Click Apply to start the first reorganization iteration.
Click Apply again to start another iteration. You may repeat this step as many times as you wish.

4. Click OK to validate the result. A Flip_Edge.x element is created in the specification tree.
The initial mesh is sent to the No Show.
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Smoothing Meshes
This task shows you how to smooth a mesh.
The cloud of points you import in Digitized Shape Editor may be noisy, for various reasons,
mainly because of a poor digitalization accuracy on the edges of parts.
This noise is found again on the meshes computed from these clouds of points or imported
in STL format.
The consequences are:
●

very noisy scans produced with the Planar Sections or Segmentations actions or

●

the reconstruction of wavy curves or surfaces and/or of very high order.

This can be partly avoided by smoothing the mesh.
●

●

●

This action cannot be used on meshes with non-manifold edges.

Since the volume of the part is reduced, some small facets may be inverted by the meshing.
Therefore we recommend you alternate Mesh Smoothing and Flip Edges actions.
Use the Activate function to process only a portion of a cloud.

Open the SmoothMesh01.CATPart from the samples directory

1. Click the Mesh Smoothing icon

and a mesh.

2. The Mesh Smoothing dialog box is displayed.
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3. Select the type of smoothing:
Choose Single effect if there is no sharp edge on the mesh to process.
●

●

Small radii will be erased.
The volume of the part will be reduced (contraction towards the center
of gravity of the part).

Choose Dual effect to reduce the distance between outliers and the
surface,
and reduce the erasing of small radii.
●

●

The reduction of the volume of the part is smaller.
A large displacement of one vertex inwards may cause the neighboring
vertices to move outwards.

4. Two other controls are available:

●

●

Coefficient : It balances the effect of the new theoretical position in
comparison
with the original position.
It varies from 0 (the vertex is not moved) to 1 (the vertex is moved to
the computed position).
Max Deviation: Check this option to control the maximum deviation
allowed
(the displacement will remain under the value set.)
❍
The deviation is the distance between a vertex and its initial
position
(not between its current position and that of the previous iteration).
❍

❍

❍

Therefore, if you want to control the maximum deviation, you have
to check the
Max Deviation option before the first Apply (it is no longer
available after the first Apply).
For a better appreciation of the quality of the intermediate meshes,
the meshes are
displayed in Flat Shading within the action.
In addition, for each step the maximum and the mean deviations
(distances between a vertex and its initial position) are displayed in
the dialog box.

Page 122

Digitized Shape Editor

Version 5 Release 16

5. Click Apply: a new mesh is computed.
This action is an iterative one: click Apply again to smooth the proposed mesh.
6. Click OK once you are satisfied.
A Smoothing.x element is created in the specification tree,
the original mesh is sent to the No Show.

Examples:
Original part, before entering the action, i.e. in Smooth Shading:
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Original part as you enter the action, i.e. in Flat Shading:

Single effect, in Flat Shading
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Single effect, in Smooth Shading (after exiting the action)
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Dual effect, in Flat Shading

Dual effect, in Smooth Shading (after exiting the action)
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Mesh Cleaner
This task will show you how to clean a mesh.
Imported STL files or generated meshes may present some irregularities such as:
●

Corrupted triangles, i.e. triangles that have the same vertex twice,

●

Duplicated triangles, i.e. triangles that share the same three vertices,

●

Inconsistent Orientation, i.e. triangles that can not be oriented consistently with respect to each other,

●

Non-manifold edges, i.e. edges shared by more than two triangles,

●

Non-manifold vertices, i.e. vertices shared by two or more connected shells.

A mesh may also present some structural problems such as:
●

Orientation problems, i.e. all the triangles are not oriented in the same direction,

●

Isolated triangles, i.e. triangles belonging to small connected areas of the mesh,

●

Disconnected zones, i.e. the mesh is made of several disconnected zones,

Digitized Shape Editor
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Triangles with long edges.

Mesh cleaner proposes two families of treatments on such meshes:
●

●

Deletion, i.e. visualization and deletion of corrupted or duplicated triangles,
of triangles with an inconsistent orientation, of non-manifold edges, or non-manifold vertices,
of isolated triangles and triangles with long edges.

Structure, i.e. re-orientation or split.

You can process simultaneously several types of problems in the Deletion tab.
Structure problems must be processed separately.
Open MeshCleaner1.CATPart the from the samples directory.

Digitized Shape Editor

1. Click the Mesh Cleaner icon
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and select the mesh to process.

The dialog box is displayed.

2. Go to the tab of the treatment you want to apply.

3. In the Deletion tab, push the Analyze button.

Once the analysis is completed, the line(s) corresponding to the problem(s) found become active.
The Statistics column is updated with the number of cases found for the four first lines.
Here, only non-manifold vertices have been found, and there are 5 such vertices.

4. You can visualize the problems found:
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Check the line(s) of the problem you want to visualize. By default, they are displayed in white.
You can choose another color in the Preview colors combo box.

5. For Isolated Triangles, use the slider to define the maximum number of triangles that a
disconnected area may contain.
If you set the slider to n, all the areas containing between 1 and n triangles will be visualized, then
deleted.
The limit values of the slider are defined according to the mesh.

6. For Long Edges, use the spinner to define the maximum allowed length edge of triangles.
All triangles with edges longer than this value will be deleted.

7. Click Apply to delete the unwanted elements and OK to exit the action and save the processed
part.

8. In the Structure tab,
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❍

Check the Orientation line and click Apply to re-orient triangles, if that is possible.

❍

or check the Split in Connected Zones. The text box below is updated with the number of
connected zones found.
You can then choose to split them in Distinct zones or in one Grouped zone by checking the
appropriate option
and clicking Apply. SubMesh.x elements are then created in the specification tree.

9. Click OK to exit the action and save the processed part.
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Filling Holes on Meshes

This task shows you how to fill holes on meshs with the following advantages:
●
You can either select the holes manually or automatically.
●

The filling can be basic (no point inserted, basic remeshing) or more sophisticated
(points are inserted, and the meshing can be flat or curved).

Open the Fillhole1.CATPart from the samples directory.

1. Select the Fill Holes icon

and Cloud Import.1.

2. The dialog box is displayed.

A first recognition of the holes is done:
❍

X means the hole is not selected,

❍

V means the hole is selected,

❍

The biggest hole found is considered as "exterior".
Since you usually do not want to fill the outside of the part, this hole is not selected, but you
can change its status.
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3. Click on the label to select or de-select a given hole or right-click on a label to call the contextual
menu:

Use Selected/Not selected as a toggle on a single hole, and Select all/De-Select all as a toggle on
all holes.

4. If you want to select the holes to fill automatically, check the Hole size option.
A sphere is displayed. You can change its diameter in the box on the right:
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❍

either enter a value,

❍

or right-click to call the contextual menu:
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All the holes smaller than this sphere are selected.

5. Click Apply. A basic meshing is computed to fill the hole:

6. Close the dialog box and repeat this step with the Points insertion option checked and click
Apply.
A new meshing is computed, with more meshing points:
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With this option, you can set a Sag and a Step (i.e. the maximum length of the mesh edges)
value,
either directly or with the contextual menu.

7. By default, the filling is flat:

Check the Shape option for a curved filling.
The filling is computed on a virtual surface, the curvature coefficient of which is controlled by the
slider on the right:
increase this coefficient to increase the curvature of the filling.

8. Click Apply to visualize the filling with given parameters.
If you are not satisfied, click Undo, modify the parameters and click Apply to refresh the filling.
Once you are satisfied, click OK to validate and exit the action
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●

Undo is available within the action, not after you have exited the action.

●

The holes to fill must be closed.

●

When no coherent result can be computed, an error message is displayed.
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Interactive Triangle Creation
This task will show you how to create mesh triangles interactively:
●
to create or modify a mesh quickly or
●

to simplify hole filing by creating bridges within a hole.

Make sure the Display is not set to Free Edges.
Open the Fillhole1.CATPart from the samples directory.

1. Click the Interactive Triangle Creation icon

.

The Interactive Triangle Creation dialog box is displayed.

2. To create a new mesh triangle, you can input:
❍

three points (vertices of an existing mesh or not), or

❍

two neighboring edges of a mesh (with a vertex in common), or
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an edge of an existing mesh and a point (vertex of an existing mesh or not).

❍

To make the selections easier:
❍
As you pass the cursor over a mesh, the edge or the vertex under the cursor are highlighted:

As you pass the cursor over a point, it is highlighted:

❍

When the first selection is a point, it is displayed in red.
❍
If the next selection is another point, a red line is displayed between those two points.
At the next point selection, a triangle is proposed and displayed in blue.
If the next selection is an edge, a triangle is proposed and displayed in blue.

❍

When the first selection is an edge, it is displayed in red.
At the next selection, a triangle is proposed and displayed in blue.

3. Once a triangle is proposed:
you can select other elements to define more triangles
(they will be proposed and displayed in blue) or

❍

click Apply. The triangle(s) displayed in blue is(are) created temporarily.
You can create further triangles.

❍

4. Click OK to validate the creation of triangles:

●

if the first element picked was a point that did not belong to a mesh,
a new Mesh.x element is created (even if the other elements selected belong to a mesh),
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The first element picked is Point.2. A new mesh is created.

●

if the first element picked was a vertex or an edge of an existing mesh,
this mesh is modified and no other mesh is created.
The first element picked is an edge of Cloud Import.1. Cloud Import.1 is modified, no
new mesh is created.

or Cancel to exit the action without creating any triangles.
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Decimating Meshes
This task will show you how to decimate a mesh.
Decimation is a command reducing the triangle count of a mesh for a quicker execution of commands.
It also reduces the memory requirements for the model.
Many large meshes can be represented accurately with less triangles.
Decimation can be performed on the entire region or a selected region of the mesh.
The mesh must be exempt of Non Manifold problems, even on non-active areas.
You should use the Mesh Cleaner.
Open the SmoothMesh01.CATPart from the samples directory

1. Click the Decimation icon

and select a mesh. The dialog box is displayed:

2. Check the type of decimation you want to apply:
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by Chordal Deviation if you want to preserve the shape of your model,
even in areas with a high curvature,

❍

by Edge Length if you want to remove triangles with tiny edges and obtain
a more uniform mesh.
However this may result in a loss of accuracy in areas with a high curvature.

3. Then, decide how you want the decimation to stop:

❍

For a decimation by Chordal Deviation, you can check Maximum and enter a
value.
It is the chordal deviation that should not be exceeded during decimation.
Decimation stops when the chordal deviation limit has been reached.

❍

For a decimation by Edge Length,
you can check Minimum and enter a value.
The command stops when further decimation could collapse edges of length
greater than the value entered.

❍

For both types of decimation,
check Target Percentage if you want to obtain a given final number or percentage
of triangles.
Enter either the percentage value or the Target Triangle Count.
Those fields are linked to each other and updated simultaneously.

Current Triangle Count indicates the current number of triangles,
either of the original model when you enter the action,
or of the result model when you have clicked Apply.
Decimation with a Chordal Deviation at 70%:
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Decimation by Edge Length set at 70%:
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4. You may need to control the decimation of free edges, when a rectangular shape sees its corners
cut off after decimation.
You can avoid this by checking Free Edge Deviation.
This activates the maximum allowable deviation that can occur for vertices on the boundary.
The resulting decimated boundary will not be at a distance greater than this parameter from
the original boundary.

5. The chordal deviation that can be used as a stopping criterion is an approximation of the chordal
deviation between the original mesh prior to decimation and the decimated mesh.
Therefore it may be useful to know the maximum distance and the mean distance between
the original mesh and the result mesh at the end of the command.

To do so, check Analysis before clicking Apply.
At the end of the decimation, the maximum and the mean deviation will be reported as shown
below.
Unlike the value entered in the Maximum field, they are the true deviations between the original
mesh
and the result mesh.

Digitized Shape Editor
❍

❍
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However, Analysis may be time consuming, especially for large models.
We recommend that you turn it off when you do not need it.
The meshes can be decimated in several steps (click Apply= one step).
The deviations displayed are those between the original model and the last result
(not those between the previous and the current results).
For this reason, the deviations will be increasing in value after each Apply.

❍

Any selection change resets the original model for the analysis.

❍

Undo is not taken into account by the Analysis.

6. Click Apply, a progress bar is displayed. A Cancel button is available to stop the decimation.

7. Click OK to confirm the decimation once you are satisfied with the result.
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Optimizing Meshes
This task will show you how to optimize an existing mesh, i.e. redistribute and reshape the triangles within the mesh.
This way you will obtain a more homogeneous mesh, e.g. for analysis purpose.
●

●

●

Be aware that this optimization tends to modify the shape of the model!
The mesh must be exempt of Non Manifold problems, even on non-active areas.
You should use the Mesh Cleaner.
Mesh Optimize is an iterative operator using edge splits and edge collapses. If an edge is too long, it is split in two.
If an edge is too short it is collapsed. Consequently, there is a minimum ratio between the minimum and
maximum edge length; otherwise an edge that has just been split could be collapsed at the next step and
then split again and so on.

Open the SmoothMesh01.CATPart from the samples directory.
You may want to display the triangles of the mesh, using the Cloud Display command.
1. Click the Optimize icon

and select the mesh.

2. Set the Minimum Length, Maximum Length and Dihedral Angle according to your needs.
❍

Minimum Length and Maximum Length refer to the length of the edges of the triangles.

❍

The Minimum Length must be less than or equal to the half of the Maximum Length.

❍

❍

❍

Dihedral Angle: The dihedral angle between 2 triangles sharing an edge is the angle
between their normals (note that this is different from the angle across the common edge).
A greater dihedral angle indicates a sharp feature across that edge for example if the dihedral angle is 0 it means that the 2 triangles are on the same plane.
All the triangles with edges shorter than the Minimum Length will be collapsed so that
their edges reach this Minimum Length.
All the triangles with edges larger than the Maximum Length will be refined so that
their edges reach this Maximum Length.

❍

Al the triangles with an Dihedral Angle lower than the value given will be flipped.

❍

Make sure the chosen values are coherent with your model.
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3. Check the Analysis option to display the maximum and the mean deviations
(distances between a vertex and its initial position) in the dialog box.
4. Click Apply.

5. Click OK to validate the optimization and modify the initial mesh,
or Cancel to exit the action without any modification.
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Operations
This chapter deals with operations on clouds:
Merging Cloud of Points
Meshes Merge
Split
Trimming or Splitting a Mesh
Projection on Plane
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Merging Cloud of Points

This task shows how to merge clouds of points.
Open the Merge1.CATPart model the from the samples directory.
It consists of three clouds of points that have been imported separately.

1. Click the Merge Clouds icon

. The Clouds Union dialog box is displayed.

2. Select the clouds you want to merge. The list in the dialog box is updated.
3. To remove a cloud from the list of clouds to merge, make its name active in the list and
push the Remove button.
4. To replace a cloud in the list of clouds to merge, remove it, then select a new cloud.
5. Once you have selected all clouds to be merged, click OK. A new cloud is created.
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●

An element Clouds Union.x is created in the specification tree.

●

You could also import a set of clouds.
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Merging Meshes

This task shows how to merge two meshes.
This action is useful especially for meshes resulting from a constrained mesh:
it removes the seam created by the constrained mesh.
This action does not modify the triangles of the meshes (holes are not filled, no management of
overlaps, ...).
For a good result, repair the meshes first, using constrained meshing, fill hole action, ....
Open the MergeMeshes1.CATPart model from the samples directory.
It consists of two meshes, the smallest resulting from a constrained meshing.

1. Select the Merge Meshes

icon . The Meshes Merge dialog box is displayed.

2. Select the meshes you want to merge. The list in the dialog box is updated.
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3. To remove a mesh from the list of meshes to merge, make its name active in the list and
push the Remove button.
4. To replace a mesh in the list of meshes to merge, remove it, then select a new mesh.
5. Once you have selected all meshes to be merged, click OK.
A new single-cell mesh is created in the specification tree under the name Meshes Merge.x.
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Splitting Meshes

This task shows how to split a mesh or a cloud.
Open the Cloud.CATPart model the from the samples directory.
Click here for more information on the dialog box.

1. Select the Split

icon . The Split dialog box is displayed.

2. Select the mesh or the cloud to split.
3. Select a portion of the element according to the Activation operating mode.
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4. Once the selection is done, click OK to validate.
5. The input element is hidden. Two elements are created in the specification tree:

❍

SplitCloud.1 and SplitCloud.2 if the input element was a cloud.
SplitCloud.1 corresponds to the remaining portion of the original cloud,
SplitCloud.2 is the split cloud (portion selected).

❍

SplitMesh.1 and SplitMesh.2 if the input element was a mesh
SplitMesh.1 corresponds to the remaining portion of the original mesh,
SplitMesh.2 is the split mesh (portion selected).

❍

The output element indexes are increased if further splits occur.
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●

●

●
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If the selection is empty, no split element is created.
To retrieve the original input element, recall it from the No Show,
or merge the two split elements.
When you split a mesh using the Trap option, the triangles are smoothly cut by the trap line.
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Trim/Split
This task will show you how:
●
to split a mesh in several meshes (displayed in different colors below):

●

and/or trim portions of the mesh delimited by curves, planes, surfaces or other meshes:

Page 155

Version 5 Release 16

Digitized Shape Editor
●

The mesh must be exempt of Non Manifold problems, even on non-active areas.
You should use the Mesh Cleaner.

●

Keep the portion of curves not taken into account at intersections as short as possible.

●

For a better understanding, the colors of the mesh portions have been changed.

Open TrimSplit1.CATPart from the samples directory.

1. Click the Trim/Split icon

. The dialog box is displayed.

2. Select the mesh to trim or split. It can consists of several cells.

3. Select the Cutting elements .
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They can be:

❍

scans,

❍

curves,

❍

planes,

❍

surfaces,

❍

meshes.

Those input elements are highlighted in the graphic area and listed in the dialog box.
To remove a cutting element, select it in the dialog box list and push the Remove button.
To replace a cutting element with another, select is in the dialog box list,
push the Replace button and select the new cutting element.
To define an area, the projection curves of the cutting elements must intersect
each other or intersect free edges.
❍

This case defines two areas:

❍

This case defines nine areas:
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❍

This case is not valid: the projection curve does not intersect any free edge.

❍

In some cases, changing the Projection type may solve the problem.
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4. Select the Projection type

When scans or curves are used as cutting elements, those entities are close to the mesh but not on the mesh.
To compute the intersection, it is necessary to project those scans or curves on the mesh to
create intersection curves.
Four projection options are proposed:
❍
View: the projection is done along the view direction,
❍

Compass: the projection direction is defined using the compass,

❍

Normal: the projection is normal to the mesh,

❍

Along a direction: the projection is done along the direction defined by the user.

The projection option applies to all cutting elements.
5. Check Preview if you want to see the projection of the cutting elements on the mesh.
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This is an example of the Preview of a plane.

For better performances you should not activate the preview unless absolutely necessary.

6. Decide whether you want to trim or split the mesh:

If you want to split the mesh:
❍

Make sure the Split option is checked. This makes the Apply button available.

❍

Click Apply. The action creates several new meshes.

If you want to trim the mesh:
❍

Make sure the Trim option is checked. This makes the scissors and crossed-scissors available.

7. Use the scissors or crossed-scissors to define the portions to be kept or removed:
❍

Push the scissors button and pick the area(s) you want to remove,
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or push the crossed-scissors button and pick the area(s) you want to keep.
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❍

Click a scissors or crossed-scissors icon to delete one occurrence, or use the contextual menu.

❍

Push the Remove All button to delete all occurrences, or use the contextual menu.
❍

Unselected areas have the opposite status.

❍

You can not mix instances of scissors and crossed-scissors.
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A contextual menu is available on scissors and crossed-scissors:
❍

Delete: Deletes the occurrence,
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❍

Delete All: Deletes all occurrences,

❍

Invert All: Replaces all occurrences of scissors by crossed-scissors and vice-versa.
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8. Select a Result option:
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❍

if you check Distinct, the output meshes will be distinct elements,

❍

If you check Grouped, the new meshes will be cells grouped in a single body.
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9. Keep Initial controls whether a new mesh is created in the specification tree or if the input mesh is replaced
by another when the command is executed.
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If Keep Initial is checked:
❍

the input mesh is sent to the NoShow and remains in the specification tree,

❍

the output meshes are created in the specification tree and the graphic area:
■

Distinct is checked

■

Grouped is checked

■
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If Keep Initial is not checked:
❍

❍

if Distinct is checked, the input mesh is removed from the specification tree,
the output meshes are created in the specification tree and the graphic area.

if Grouped is checked, the result multi-cells mesh replaces the input mesh:
■
the input mesh is removed from the graphic area but its name remains in the specification tree,
■

the result multi-cells mesh is created in the graphic area and under the name of the input mesh
in the specification tree.

We recommend that you do not keep initial large meshes.
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10. Click Apply to preview the result.
11. Click OK to validate and exit the action.
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Projection on Plane
This task will show you how to project a cloud of points or a mesh on a plane to obtain a planar cloud of
points or mesh or to create a planar scan.
After the mesh projection, the free boundaries do not correspond to the silhouette contour.
Open the ProjectMesh1.CATPart model from the samples directory.

1. Click the Projection on Plane icon

.

2. The Projection On Plane dialog box appears:

3. Select Mesh Creation.1 as the element to project.
Multi-selection is available. The elements to project can be one or several clouds of points or
meshes.
Click the

icon to visualize, Remove or Replace elements in the selection.

4. Select the xy plane.
You can select an existing plane, or use the contextual menu:
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5. Select one of the output options:
❍

❍

Distinct to create one output element for each input element,
Grouped to create one single output element.

6. Click Apply. The mesh is projected on the selected plane:

7. Click OK. ProjectionOnPlane.1 is created.
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Creating Scans or Curves
This chapter deals with the creation of scans or curves on a cloud of points.
Projecting Curves
Cutting by Planar Sections
Creating Scans
Free Edges
Creating Associative 3D Curves
Creating Associative 3D Curves on a Scan
Curves from Scans
Performing a Curvature Analysis
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Projecting Curves
This task shows how to project curves on clouds of points or meshes.
The action proposes options to:
●

project the curves perpendicularly onto a mesh (not available for clouds of points),

●

modify the projection direction,

●

smooth computed scans directly into curves.

Open the CurvesOnCloud1.CATPart model the from the samples directory.
You can use either the cloud or the mesh.

1. Click the Project Curves icon

. The curve projection dialog box is displayed.

2. Select the curves to project and the target cloud or mesh.

Curves can be selected:
❍
from the specification tree,
❍

with a selection trap,

❍

with the preselection navigator.

3. If the target is a cloud of points, the projection is automatically computed along a direction.
If the target is a mesh, you can select the Projection type from the list:
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4. If the projection is computed along a direction, the direction proposed by default is the Z axis.
You can choose another direction, using the contextual menu of the Direction field:

❍

❍

the Edit Components option let you enter the coordinates of the direction:

The Compass Direction option takes the compass current orientation as the projection direction.
If you want to change this direction, modify the compass orientation and re-select Compass Direction
to take the new direction into account.

5. If the target is a cloud of points, you may set the working distance:
the input curve is discretized, and each discretization point is projected on the cloud.
The working distance is the distance taken into account around each projection point to compute
the output scan.
Enter 10 then 3 :
The working distance is 10
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The working distance is 3

6. You can set a sag value:
the curve to project is discretized according to this sag value, and each discretization point is
projected on the mesh.
The Sag is set to 1

The Sag is set to 0.01
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7. If you want to create curves, check the Curve creation option.
The operating mode is the same as for the Curve from Scans action except that only the curvature comb
(no curvature analysis dialog box) is displayed.

Page 176

Digitized Shape Editor

Version 5 Release 16

❍

If the Curve creation option is checked, curves and only curves will be created.

❍

If the Curve creation option is not checked, scans and only scans will be created.

❍

❍
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If you need a complete curvature analysis of the curves you create, you have to create the scans first,
and then create the curves with the Curve from Scans action.
When you modify a parameter, click Apply in the corresponding dialog box to take it into account.

8. Click Apply to check or update the result. Then click OK to confirm the result and exit the action.

❍

Scans are created in the specification tree under the name Curve Projection.x.

❍

Curves are created in the specification tree under the name Curve.x.
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Cutting a Cloud of Points or a Mesh by Planar
Sections
This task shows how to cut a cloud of points or a mesh by planes to compute scans
and to smooth those scans directly to curves.
The computation of sections with limiting curves has been improved:
●
You no longer need to check the Lock Privileged Plane Orientation Parallel to Screen
option of the compass.
●

●

But be careful to choose a view parallel to the screen.
This enhancement enables you to define planar sections with the compass
while using limiting curves.

For an easier selection of curves, you can use the pre-selection navigator
(see the Infrastructure User Guide for more information).
Although cutting a cloud of points is quicker (no need to mesh first), creating planar sections on a mesh
rather than on a cloud of points has some advantages:
●
the action is dynamic on meshes: no need to apply to visualize the modifications
(position of the reference plane, step, number of planes,...),
●

●

In the case of a cloud of points, the intersection may be interpolated, since the plane does not necessarily
intersect points. That problem is reduced with meshes since the plane intersects facets,
providing a better accuracy.

if you process an hybrid CloudsUnion element made of a mesh and a cloud of points,
the planar sections will be created on the mesh only.

Open the Cloud.CATPart model the from the samples directory.

1. Click the Planar Sections icon

and the cloud of points or the mesh.

The Planar Sections dialog box is displayed with its default settings (as shown below):
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❍

Number (of sections) is 1,

❍

Step value is 1,

❍

The Scans option is set to Grouped.

❍

Fixed is set to Step.

❍

The cutting planes are parallel to either YZ, XZ or XY depending on which is
perpendicular to the largest edge of the working box.

❍

The status of the Infinite, Fixed and Scans are modal,

❍

The Number and Step values are modal.

2. Use the Plane Definition

icons to select the reference plane according to your need:
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❍

push the YZ

❍

push the compass icon

❍

push the plane icon

❍

or XZ

or XY
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icon to select a predefined plane, or

to orient the reference plane with the compass, or
to select an existing plane or

Push the section guide icon
and select a curve: the sections will be perpendicular to this curve.
The degree of the section guide must be greater than 2.
It is not possible to input a join (in the Generative Shape Design sense) as a section guide.
❍

❍

❍

One manipulator is available on the reference plane.
It can be used to position the reference plane either by dragging the manipulator or
by using the contextual menu Edit.

Another manipulator is available on the last cutting planes proposed.
This manipulator is used to modify either the step between cutting planes,
or the number of planes, depending on the option selected in the Fixed field
or in the contextual menu attached to this manipulator.

Check the Keep this point option on any of those manipulators to create the corresponding
point.

3. After setting the orientation of the reference plane, you can move it along its normal or
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along the section guide by dragging the center of the green manipulator in the required direction.

4. If required, you can select one or two limiting curves for any of the plane option.

❍

Pick the first limiting curve, its name is displayed in the First curve field.

❍

You can then select a second limiting curve. Its name is displayed in the Second curve field.

❍

To replace a limiting curve by another, uncheck the corresponding field: the name is erased.
Check the field again and select the new curve. Its name is displayed.

❍

The limiting curves should lay on the cloud of points or the mesh.

❍

The section guide curve can be selected as second limiting curve (not as the first).

❍

When using a limiting curve, the scans may be created on the "wrong" side of the curve.
In fact, this side is determined by the origin of the reference plane.
So move the reference plane to create the scans on the "right" side, either with the contextual
Edit menu of the plane, or using the compass.

5. Cutting planes can be defined :
❍

either from the step (distance) between two consecutives planes:
■
check Fixed, Step,
■

■

❍

then enter the value of the Step in the dialog box,
and enter the Number of planes in the dialog box or drag the green arrow until you reach the
required number of planes (the dialog box is updated automatically).

or from their number :
■
check Fixed, Number,
■

■

then enter the Number of planes in the dialog box,
and enter the Step between two planes or drag the green arrow until you reach the required step
(the dialog box is updated automatically).

You can also check the Infinite option, especially when dealing with large models.
In that case, the planes displayed on screen are used only to position the reference plane and
define the step between two planes, if it is not fixed.
The system computes all the cutting planes necessary to cut the whole model.
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6. The Influence Area parameter defines a computation area around the cutting planes:
when the points are not dense, a cutting plane (black line) may be unable to intersect the points.
The Influence area is the area shown in yellow that contains the points considered to intersect
the cutting plane. You can define its value according to your needs.
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7. Select the type of the result scans: either :
❍

❍

Distinct: the intersections are created as as many Planar Sections elements in the specification tree.

Grouped: the intersections are created as one cloud (one Planar Sections element) in
the specification tree.
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8. If you want to create curves, click Apply in the Planar Sections dialog box to display a scan in the
specification tree and check the Curve creation option.
The operating mode is the same as for the Curve from Scans action except that only the curvature
comb
(no curvature analysis dialog box) is displayed.
❍

If the Curve creation option is checked, curves and only curves will be created.

❍

If the Curve creation option is not checked, scans and only scans will be created.

❍

❍

If you need a complete curvature analysis of the curves you create, you have to create the
scans first,
and then create the curves with the Curve from Scans action.
When you modify a parameter, click Apply in the corresponding dialog box to take it into
account.

9. Click Apply to check or update the result. Then click OK to confirm the result and exit the action.
❍

The scans are created in the specification tree, as Planar Sections.x.

❍

The scans created are ordered.

❍

Scans can then be exported to an ASCII file.
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Creating Scans
This task shows you how to create scans by picking points on the cloud.
Open the ScanOnCloud1.CATPart from the samples directory.

1. Click the Scan on Cloud icon

and a cloud.

This first pick selects the cloud and defines the first point of the scan.
2. Pick points on the cloud to create the scan.

3. Double-click to exit the action. A Scan_on_Cloud.x element is created in the specification tree.

●

Undo and Redo are available for each pick.

●

One single scan can be created over several clouds.

●

If you press the Ctrl key wile moving the cursor on the cloud,
the creation of the scan is displayed interactively.
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Creating Free Edges
This task shows you how to create scans or curves by creating the free edges of a mesh.
You can:
●

create scans on all the existing free edges, or only selected free edges,

●

create scans on the whole free edge or only a portion of it, and select which portion,

●

create curves directly from these scans and check their curvature if required.

●

This action is available for meshes only!

●

This action is available on a complete mesh or on a portion of it .

●

If the Curve creation option is checked, curves and only curves will be created.

●

If the Curve creation option is not checked, scans and only scans will be created.

●

●

If you need a complete curvature analysis of the curves you create, you have to create the scans first,
and then create the curves with the Curve from Scans action.
When you modify a parameter, click Apply in the corresponding dialog box to take it into account.

Open the FreeEdges1.CATPart from the samples directory

1. Click the Create Free Edges icon

and select a mesh.

The dialog box is displayed and scans are proposed in cyan.
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2. Select the scans to process.
By default, all computed scans are proposed.
Place the cursor on a label Selected and right-click to launch the contextual menu.

You can:
❍

Select or deselect singles scans,

❍

Select or deselect all scans.

3. If necessary, pick two points on a selected scan to define a portion of scan to create.
Both extremities of the scan are displayed, together with its direction (as a red arrow).
You can invert this direction by clicking on the red arrow.
Proposed direction, Before Apply

After Apply
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After Apply

4. To remove one extremity point, right-click on its label to start the contextual menu:

5. Click Apply to apply any change you make.
6. If you want to create scans, check the required option:
❍

Distinct to create distinct scans,

❍

Grouped to create one single scan.

7. If you want to create curves, check the Curve creation option.
The operating mode is the same as for the Curve from Scans action except that only the curvature comb
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(no curvature analysis dialog box) is displayed.
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Creating Associative 3D Curves

This task explains how to create a 3D curve that is associative meaning you can add or delete points (whether control points or passing
points) both at creation time or when editing.
These curves can be created in space or lie on a geometrical element, or both. When the curve lie on a geometrical element and the later is
modified, the curve is updated automatically, provided you choose the Automatic update option in Tools -> Options -> Mechanical
Design -> Assembly Design -> General tab.
●
Selecting all 3D points
●

Editing

●

Keeping a point

●

Imposing a tangency constraint

●

Imposing a curvature constraint

●

Setting as arc limit

Open a new CATPart document.
1. Click the 3D Curve icon

.

The 3D curve dialog box is displayed.
2. Choose the curve creation type.

●

Through points: the resulting curve is a multi-arc curve passing through each selected point.

●

Control points: the points you click are the control points of the resulting curve
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Near points: the resulting curve is a single-arc, with a set degree and smoothed through the selected points.

You can edit the order by right-clicking the displayed text (displayed using the U, V Orders icon

from the FreeStyle

Dashboard or the Order option from Tools -> Options menu, Shape -> FreeStyle -> General tab), and choosing a new order
value.
The Automatic order option enables you to automatically compute an order that will respect at best all the curve constraints.
The computed value is displayed near the Auto tag.

●

The Deviation option enables the user to set the maximum deviation between the curve and the construction points.

The result is a set degree through the selected points.
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The Segmentation option enables the user to set the maximum number of arc limits. These arcs are construction points and are
inserted into the curve automatically.
The minimum value is set to 1.
The Max Order option enables you to set a bound for the computation of a mono-arc curve.
This option is only available with the Control Points and the Near Points types (provided the Automatic Order is selected).
❍
Control Points: when the Max order value is exceeded, the mono-arc curve becomes a multi-arc curve. As a consequence, the Max
order value is no longer taken into account, as arcs have always 6 as order.
❍

Near Points: you cannot create a 3D curve with an order higher than the Max order value. The Max order value is always taken into
account, whatever the result (mono-arc or multi-arcs curve).

The minimum value for the Max order option is set to 5 for Control Points and 2 for Near Points. If the value defined in Tools -> Options > Shape -> FreeStyle is set to 5, then, for Control Points, the Max order value is 6 (minimum and maximum bounds must be different).
The maximum value for the Max order is the same as defined in Tools -> Options -> Shape -> FreeStyle. If you decrease the value in
Tools -> Options and it is lower than the Max order value, then the latter value prevails.
●
Smoothing options are available to parameterize the curve:
●

●

●

Chord Length (default parameterization)
Smoothing parameter = 0

Uniform
Smoothing parameter = 0

Smoothing parameter: enable a better control points distribution of
the smoothed curve.
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Smoothing parameter = 130

Deviation, Segmentation, and Smoothing options are only available for the Near Points creation type.
3. Move the pointer over a point.
A manipulator is displayed allowing you to modify point location as you create the curve.
By default, this manipulator is on the last created point.
A contextual menu proposes several options to construct the 3D curve.
Right-click on the manipulator to display the contextual menu. From then on you can choose the Edit item to display the Tuner dialog box
and enter space coordinates for the selected point, or choose the Impose Tangency item to set a tangency constraint on the curve at this
point.
4. Click the Insert a point icon

within the dialog box.

The curve freezes.
5. Click the segment, between two existing points where you wish to add a new point and click the point location.

Once the point has been created, you are back to the edition capabilities on the curve.

6. Click the Remove a point icon

within the dialog box, and select one of the existing points.

The curve is recomputed immediately without the selected point.

7. Click the Free or constrain a point icon

within the dialog box, then select the point.

Digitized Shape Editor
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If the point is a point in space (free), move the pointer close to the point or a wire to which it should be linked. You can then move the
pointer over a geometric element and:
❍

move the point to the indicated point by clicking

❍

press and hold the Control key (Ctrl) to project this point onto this element according to the shortest distance from the point initial
location.

●

If the point was lying on another point or a wire (curve, line, spline, and so forth), it is freed from its constraint onto this element, and
can be moved to any new location in space.

You can snap a point onto a surface using the Free or constrain a point icon. The point will be lying onto the surface, but not
constrained. It can be moved using the manipulators.
8. Click OK to create the curve.
A 3DCurve.xxx appears in the specification tree.

●

●

Check the Disable geometry detection button, when you need to create a point close to a geometric element yet without
constraining it onto the existing geometry.
Check the Hide previsualisation curve to hide the previsualisation curve you are creating.

Selecting all 3D points
It is possible to select all the points either in the specification tree or directly in the geometry.
The Select all points contextual menu is available within the 3D curve action only, when the 3D Curve dialog box is open.
●

●

In the specification tree:
❍
select the geometrical set just by clicking it, or
❍

right-click the geometrical set and choose Select all points in the geometrical set from the contextual menu, or

❍

select a point in the geometrical set, right-click it and choose Select all points in the geometrical set from the contextual menu.

In the geometry: select a point, right-click it and choose Select all points in the geometrical set from the contextual menu.
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Contextual Options
Double-click your curve, right-click on the manipulator to display the contextual menu.

According to the creation type, the following options are available:
Through Points

Control Points

Near points

Edit

X

X

X

Keep this point

X

X

X

Impose Tangency

X

X

Impose Curvature

X

X

Set as Arc Limit

X

Remove this point

X

X

X

Constrain this point

X

X

X

Editing
1. Right-click any of the manipulators, and choose the Edit contextual menu to display the Tuner dialog box. This option allows you to
redefine the tangency position (X, Y, and Z axes), and its vector's step.
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The Relative check box enables you to redefine the tangency relative position (X, Y, and Z axes), and its vector's step.
The Reset Origin button allows you to reset the origin of the relative position.

Keeping a point
1. Right-click an existing point and choose the Keep this point menu item to create a point at this location.
A datum Point.xxx appears in the specification tree.
You can create a Point.xxx either on each control point or on the selected control points.

Imposing a Tangency Constraint
Automatic Constraint
●

When a curve is created in Through points or Near points mode, and its first point is constrained on any point of another curve, the
new curve automatically is tangent to the curve on which its first point is constrained. As soon as the curve's second point is created,
the imposed tangent is displayed on the new curve.
To deactivate the default option, uncheck the Impose Tangency contextual menu on the tangent vector.
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Tangency Constraint on Points
When creating a 3D curve, you may want to impose tangency constraints on specific points of the curve. Then if you move the point at
which a tangency constraint has been set, the curve will be recomputed to retain this tangency constraint at the point's new location.
Depending on the creation mode, you can impose this constraints on a limited number of points:
●
In Through points mode: tangency can be imposed on any point
●

●

In Near points mode: tangency can be imposed independently on each end points only
In Control points mode: no tangency constraint can be imposed (end points can be constrained on other elements as described in step
7 above. See also Constraining a Control Points Curve.

Here is how to do it:
Open the FreeStyle_03.CATPart document.
1. Move the pointer over an existing point, double-click it (the 3D curve dialog box appears), then right-click and choose the Impose
Tangency menu item.
Two sets of manipulators are displayed:
●
two arrows representing the normed directions (vectors) of the tangency
●

circles representing manipulators for this vector

You can also modify the tangency constraint by:
●
pulling the arrow
●

gliding the circles

●

double-clicking the arrow to invert the tangency direction

You can set the tangency length by clicking on the arrow then dragging the mouse.
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Right-clicking on any of the manipulators, you can also choose to define the constraint according to an external element:
●
Use current plane orientation (P1)/Use compass normal (P2): the tangency constraint is defined in relation to the normal to the
current plane, possibly defined by the normal to the compass main plane
When several points are constrained on the compass, all are modified if the compass settings are changed.
When this option is checked, the direction cannot be modified directly using the vector manipulator, but only using the compass.

●

Constrain on element: available only when a point is already constrained on a curve. The curve being created/modified becomes
constraint in tangency or curvature to the constraining curve at this point.
❍
Tangency constraint: in this case you can only modify the vector's norm using the Edit contextual menu, and no longer the vector's
direction, the latter being defined by the constraining curve.
❍

Curvature constraint: in this case you neither modify the vector's norm using the Edit contextual menu, nor the vector's direction,
the latter being defined by the constraining curve.

By default, when the tangency vector is constrained onto another curve, its initial direction is retained.
●

Snap on elements: the vector's direction is defined by an external element. Grabbing a manipulator, you drag the pointer over a
curve, and the curve becomes tangent to the curve detected by the pointer.
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If the pointer is over a point the direction is computed as the line going from the constrained point and the detected point.
If the pointer is over a plane, the tangency is defined by the normal to this plane.

●

●

When snapping on an element, use the Control (Ctrl) key to obtain an exact snap, taking into account both the detected element and
the vector's norm.
Use the Shift key as a shortcut to activate/de-activate the Snap on elements option when passing the pointer over geometric
elements.

Once you are satisfied with the tangency constraint you imposed, simply release the manipulator and move the pointer around to recover
the curve preview indicating that you are ready to create a new point.

Control Points Curve Constraint

Even though you cannot impose a tangency constraint on a curve created in Control points mode, you can constrain its end points on
another curve, as described in step 7 above.
When setting a constraint on an end point, a text is displayed indicating the type of continuity between the two curves.

Right-click the text to display the contextual menu from which you can choose another continuity type: tangency, or curvature.
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Note that:
●
in Point continuity, only the selected point is constrained
●

in Tangent continuity, the selected point and the next one are constrained

●

in Curvature continuity, the selected point and the next two points are constrained

This means that these second and third points will be modified if you move the constrained point along the constraining element, using the
manipulators. However, you cannot constrain these points, because they are considered as already constrained. If you try to do so, a
warning message is displayed. Nevertheless, you can add/remove points directly after the constrained end point, and the system resets the
points as second and third points to be affected by the constraint, where applicable.
A Continuity warning is displayed when trying to move the manipulators in a direction that is not compatible with the set constraint.

Imposing a Curvature Constraint
Right-click an existing point and choose the Impose Curvature menu item. An arrow representing the curvature direction (vector) is
displayed. Modifying the vector direction modifies the curvature direction.
The direction of the curvature is constrained in the plane defined as normal to the tangent vector.
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●

To impose a curvature continuity, you must ensure that a tangency continuity already exists.

●

This option is only available for the Through points and Near Points creation type.
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Setting as Arc Limit
Right-click an existing point and choose the Set As Arc Limit menu item to start/stop an arc limit on this point. The curve will pass
through this point.

This option is only available for the Near points creation type.
●

Use the F5 key to move the manipulators into a different plane of the compass. See Managing the Compass.

●

Use the standard shortcuts (Ctrl and Shift keys) to select, multi-select, and unselect any combination of control points on these curves.

●

●

You cannot add a point past the end points. To do this, you need to add a point before the end point, move the new point where the
end point lies, then move the end point to a new location.
The creation plane for each free point is defined according to the current plane/compass orientation on the previous point. Therefore
you can change creation planes within the same curve, by setting a new current plane/compass orientation on several points.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, temporary analysis, auto
detection (except for Snap on Control Point option), attenuation, and furtive display.
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Creating Associative 3D Curves on a Scan
This task explains how to create a 3D curve on a scan:
●

either before entering the 3D curve action. In that case, you can select only one scan,

●

or after entering the 3D curve action. In that case, you can select one or more scans.

●

●

either graphically. In that case, use the contextual menu Select all points to create a 3D curve on all
the points of the scan,
or from the specification tree. In that case all points of the scan are taken into account even if you do
not activate the Select all points menu.

Open the FreeStyle_04.CATPart document.
1. Click the 3D Curve icon

.

The 3D curve dialog box is displayed.
2. Choose the curve creation type.

●

Through points: the resulting curve is a multi-arc curve passing through each selected point.
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Control points: the points you click are the control points of the resulting curve.

Near points: the resulting curve is a single-arc, with a set degree and smoothed through the selected
points.

3. Click OK to create the curve.
A 3DCurve.xxx appears in the specification tree.

For further information on the options of the dialog box, please refer to the Creating Associative 3D
Curves chapter.

Selecting all points in a scan of cloud
It is possible to select a scan of cloud either in the specification tree or directly in the cloud from the
contextual menu:
The Select all points contextual menu is available within the 3D curve action only, i.e. it appears when the
3D Curve dialog box is open.
●

Right-click the Scan on Cloud.xxx in the specification tree and select Select all points in the scan.
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Right-click the cloud and select Select all points in the scan.

Here is an example with Through Points

Contextual Options
Double-click your curve, right-click on the manipulator to display the contextual menu.
Please refer to the Creating Associative 3D Curves to get the corresponding information.
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Only scans of the type "scan on cloud" can be selected since other types of scans might contain too many
points.
●

●

●

●

Use the F5 key to move the manipulators into a different plane of the compass. See Managing the
Compass.
Use the standard shortcuts (Ctrl and Shift keys) to select, multi-select, and unselect any combination
of control points on these curves.
You cannot add a point past the end points. To do this, you need to add a point before the end point,
move the new point where the end point lies, then move the end point to a new location.
The creation plane for each free point is defined according to the current plane/compass orientation on
the previous point. Therefore you can change creation planes within the same curve, by setting a new
current plane/compass orientation on several points.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum
creation, temporary analysis, auto detection (except for Snap on Control Point option), attenuation, and
furtive display.
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Curves from Scans

This task shows how to create curves from a scan or a set of scans.
The Curve from Scans action tries to create curves
●

with the defined tolerance,

●

with the least possible number of segments of the least possible order.

The Curve from Scans action proposes a dynamic definition of split points.
Open the CurveFromScan.CATPart model from the samples directory.
For a better understanding, some images below show only one scan.
1. Select the Curve from scans icon

and a set of scans.

The Curve from Scans dialog box is displayed.

The scan is displayed in the "Polyline+Point" mode with the current graphic symbol.
By default, the end points are fixed.

●

●

Scan modifications are not dynamic.
You have to click on Apply to take new parameter values into account.
The scans can be selected in the specification tree.
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2. Make sure the Smoothing Creation mode is checked.
3. Click Apply. A temporary curve is displayed in white, indicating the tolerance is met.

4. Change the Split Angle value to 60. A Split point is automatically inserted at the angle.

5. Push the

6. Release the

icon to display the curvature analysis:

icon and now push the

icon to display the maximum deviation
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icon to display the order and the number of segments:

7. Click OK to exit the action and create the curve(s).
Curve.x elements are created in the specification tree. The segmentation display is erased.

Parameters
Creation mode
Two creation modes are proposed:
●

Smoothing or

●

Interpolation.

In the Smoothing creation mode, the curve is created by smoothing all the points between two split points.

Three parameters are available in this mode:
●
Tolerance,
●

Max. Order,

●

Max. Segments
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Tolerance is the maximum distance between the curve and the points.
●

Decrease the value of Tolerance to reduce that distance.

●

You can check the distance between the curve and the points with the

●

If the tolerance is met, the computed curve is displayed in white.

icon.

If the maximum deviation display is activated, the maximum error is displayed in green.

●

Otherwise, the computed curve is displayed in red.
If the maximum deviation display is activated, the maximum error is displayed in red.

Max. Order is the maximum order of the curves created, i.e. the number of control points of those curves.
Max. Segments which is the maximum number of spans between two cutting points.
The Curve from Scans action tries to create curves with the defined tolerance,
with the least possible number of segments of the least possible order. I.e.:
●
the action tries to create a curve with one segment of order 2.
●

●

If the tolerance is not reached, the order of the segment is increased up the the Max. Order value.
If the tolerance is not yet reached, the number of segments is increased, the segments having the least possible order.
This order is increased to meet the tolerance, then the number of segments,
and so on until both the maximum order and the maximum number of segments are reached.

You can check the segmentation and the order of the curves with the

icon.
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In the Interpolation mode, the curve is created by interpolating the points of its support scan.

No parameters are proposed for this mode

Visualization and Analysis icons
Three visualization icons are available:

analyzes the curvature of the resulting curves:
●

This is a temporary analysis, no analysis element is created in the specification tree.

●

Click on More to display more analysis options.

●

Click on Less to display the quick analysis options

●

More information is available in the Curvature Analysis section.

displays the maximum deviation (not available for the Interpolation mode):
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The label is green if the tolerance is met, otherwise it is red.

displays the order and the number of segments (not available for the Interpolation mode):
When the curve computed is segmented, the segmentation is displayed with blue x symbols.
This color and symbol are not editable.

Push the icons to activate the display, release the icon to erase the display.
Those three displays can be combined together.

Split angle
A split angle is proposed by default at 90 degrees. This value is editable.
Whenever the computed curve forms an angle greater than this value, it is split automatically into two curves.
The split point is displayed and two curves are created.
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If you modify the split angle value after having computed curves and before having validated them,
the display of the split points is updated. Click Apply to update the display of the computed curves.
You can also:
●

add split points by picking points of the scan.

●

or move a split point to another point of the scan:

●

●

pick the split point you want to move: press the control key and the left-click on the label of the split point,
with the control key and the left button of the mouse still pressed, drag the split point
to the required scan point and drop it there.

The default constraint on a split point is "Point", i.e. passage.
Click on the green label to change it to "Tangent". A second click will return it to "Point".
You can also use the Impose tangency of the contextual menu of the constraint.

This contextual menu can also be used to remove one split point or all split points.
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End points
End points propose more items in their contextual menu.

You can remove the extremity point of a computed curve, and replace it with a new or existing split point.
Remove the end point:

The end point is removed:
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Pick a point on the scan:

Click Apply to visualize the new curve:

You can free or constrain the end points by checking the appropriate option in the contextual menu.

Label

Meaning
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O

O

O

Not
available

Free

The extremity is free

X

O

O

Not
available

Fixed

The extremity is fixed, it is the
scan extremity (this is the option
by default)

X

O

X

Not
available

Fixed on
element

If the element is a point, the
extremity of the curve is this
point, not the scan extremity
See constrain on element

If the element is a curve, the
curve extremity is the nearest
extremity of the constraining
curve
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See constrain on element

If the element is a plane, the
curve extremity is the point of
the plane nearest to the scan
extremity
See constrain on element

X

X

X

X

O

X

Available

Available

Fixed and
tangent

Fixed and
tangent on
element

The tangency direction is given
by a vector going through the
first (or the last) two points of
the scan.

The extremity is fixed and
tangent to the constraining
element.
See constrain on element
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O

O

X

Not
available

Free on
element

The extremity is free and
depends on the element.
See constrain on element

O

O

X

X

O

X

Available

Available

Free and
tangent

Free and
tangent on
element

The extremity is free. The
tangency direction is given by a
vector going through the first (or
the last) two points of the scan.

The extremity is free and
depends on the element. The
tangency direction is given by the
element (plane or curve).
See constrain on element

Constrain on element:
The extremity of the curve computed is the scan extremity, unless the Constrain on element option is checked.
●

●

●

If the constraining element is a point, the curve extremity is that point,
if the constraining element is a curve,
the computed curve extremity is the nearest extremity of the constraining curve,
if the constraining element is a plane,
the curve extremity is the orthogonal projection of the scan extremity on to the plane.

If an extremity is constrained on an element, and if a tangency is imposed, the tangency direction is given by:
●

the tangent vector of the curve on the constraining curve extremity,

●

or the normal to the constraining plane.
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Whenever the Impose tangency is checked, you can modify the tangent vector with the following box
(Edit tangent in the contextual menu):

●

It is useful to impose a tangency constraint at the extremities if you intend to reconstruct a part in two steps:
❍
reconstruction of the first half of the part,
❍

recovery of the whole part by performing a symmetry.

The tangency constraint will ensure that the two halves fit perfectly.
●

Only the tangency direction is taken into account, the norm is not.

This option is available in the Curve from Scans action only.
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Performing a Curvature Analysis
This task shows how to analyze the curvature of curves, or surface boundaries.

Open the FreeStyle_10.CATPart document.
When analyzing surface boundaries:
●

●

if you select the surface, the analysis is performed on all its boundaries

if you select a specific boundary, the analysis is performed only on this boundary.
Make sure the Geometrical Element Filter selection mode is active from the User Selection Filter toolbar.
This mode lets you select sub- elements.

1. Click the Porcupine Curvature Analysis icon:

2. Select the curve.

Automatically the curvature comb is displayed on the selected curve:
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3. Define the analysis parameters in the Curvature Analysis dialog box.

●

●

Use the Project on Plane checkbox to analyze the projected curve in the selected plane referenced
by the compass.
If you uncheck the Project On Plane option, the analysis is performed according to the curve
orientation. This is the default option.

4. Use the spinners to adjust the number of strikes and modify the density.

5. You can also decide to halve the number of spikes in the comb clicking as many times as wished the /2
button.
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This option is particularly useful when the geometry is too dense to be read but the resulting curve may
not be smooth enough for your analysis needs.
You could just as well double the number of spikes using the X2 button.

6. Similarly, click the /2 button to fine-tune the amplitude (size) of the spikes, and re-compute the analysis
curve accordingly.

7. Click Curvilinear to switch from the Parametric discretization mode to the Curvilinear analysis. You will
get something like this:
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8. Check the Automatic option optimizes the spikes length so that even when zooming in or out, the spikes
are always visible.

9. Check the Logarithm option to display the logarithmic values in the 3D geometry.

Displaying these values does not modify the analysis.

10. Click Reverse, you will get something like this:
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That is the analysis opposite to what was initially displayed. This is useful when from the current
viewpoint, you do not know how the curve is oriented.

11. Use the Particular checkbox to display at anytime the minimum and the maximum points.

Inflection points are displayed only if the Project on Plane and Particular checkboxes are checked.

12. The Inverse Value checkbox displays the inverse value in Radius, if Curvature option is selected, or in
Curvature, if Radius option is selected.
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You can right-click on any of the spikes and select Keep this Point to keep the current point at this
location.
A Point.xxx appears in the specification tree.
If you check the Particular option, you have more options:

●

Keep all inflection points

●

Keep local minimum (corresponds to the absolute minimum under the running point)

●

Keep local maximum (corresponds to the absolute maximum under running point)

●

●

Keep global minimum (in case there are two curves, the point will be found on one or other of the
curves)
Keep global maximum (in case there are two curves, the point will be found on one or other of the
curves)

13. Finally, click the

icon to display the curvature graph:

The curvature profile and amplitude of the analyzed curve is represented in this diagram.
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When analyzing a surface or several curves, i.e. when there are several curvature analyses on elements
that are not necessarily of the same size for example, you can use different options to view the analyses.
For example, when analyzing a surface, by default you obtain this diagram, where the curves color match
the ones on the geometry.

●

Same vertical length

: all curves are displayed according to the same vertical length, regardless

of the scale:

●

Same origin
scale:

: all curves are displayed according to a common origin point on the Amplitude

Digitized Shape Editor

●
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Vertical logarithm scale
: all curves are displayed according to a logarithm scale for the
Amplitude, and a linear scale for the Curve parameter:

Depending on the chosen option, values displayed in the diagram are updated.
The last icon

is used to reframe the diagram within the window, as you may move and zoom it within

the window.
14. Right-click a curve and choose one of the following options from the contextual menu:
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●

Remove: removes the curve

●

Drop marker: adds Points.xxx in the specification tree

●
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Change color: displays the Color selector dialog box that enables you to change the color of the
curve.

15. Slide the pointer over the diagram to display the amplitude at a given point of the curve.
You can slide the pointer over the diagram and the 3D analysis.
Click the x in the top right corner to close the diagram.

16. Click OK in the Curvature Analysis dialog box once you are satisfied with the performed analysis.

The analysis (identified as Curvature Analysis.x) is added to the specification tree.
In case of clipping, you may want to temporarily modify the Depth Effects' Far and Near Limits. See
Setting Depth Effects in Infrastructure User Guide.
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Display Options and Graphic Properties
This task shows how to change the display option of clouds of points.
Open the Visu1.CATPart model the from the samples directory.
It consists of four clouds of points:
●
a mesh,
●

a cloud of points,

●

a set of scans,

●

a set of grids.

Their default colors are respectively:
●
orange,
●

green,

●

cyan,

●

cyan.

The display options are available from the Cloud Display Options box.
Further graphic properties are available from the Edit/Properties menu, in the Graphic tab.
From the Cloud Display Options box, you can:
●

Choose the sampling of clouds of points (N of 100 points are displayed).

●

Choose to display scans or grids as polylines, points, or both.

●

Choose to display triangles, free edges, non-manifold edges of meshes.
You can also choose their display mode: flat or smooth.

From the Edit/Properties menu, you can:
●

Choose the fill color of the mesh and its transparency level,

●

Choose the color and symbol of the points of a cloud,

●

Choose the color, type and thickness of scans and grids,

●

Choose to elements pickable or not.

Cloud Display Options box
The images below are only examples.
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1. Click the Cloud Display icon
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at the bottom of the screen.

The Cloud Display Option dialog box is displayed.

2. Select the cloud to modify. Display options are proposed according to the type of the cloud
selected:
Following options are not yet available:
❍
Protected,
❍

Orientation,

❍

Shrink,

❍

Normal.
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3. Choose the display options:

❍

For the cloud of points, you can choose to display only a percentage of the points making the
cloud,
using the Sampling option.
By default, 100% of the points are displayed. You can change this value with the associated
spinner.

Sampling=100

Sampling=25

The Symbol options are not available in that box, but in the Graphic Properties menu.
❍

For the sets of scans or grids, you can display them as line of points or points or both:
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❍

For the mesh, you can:
■
display the triangles,

■

visualize only the vertices for a lighter display
(do not forget to de-activate the Smooth, Flat or Triangles options)

instead of
■

the free edges in yellow,

■

the non-manifold facets and their vertices in bold white lines.
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If you choose the display of triangles, the triangles accepting a non-manifold edge have
their edges displayed as regular white lines.

■

display the mesh as a smooth or a flat mesh.
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or

The free edges displayed are those of the complete cloud of points:
●
if you activate only a portion of a cloud of points, the free edges of that portion are not displayed.

Digitized Shape Editor

●

●

●
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if you remove a portion of a cloud of points, the free edges of the remaining portion are displayed.

If you move a cloud of points or a mesh, its graphic display options (not the graphic properties) are
lost.
The display options are not saved in the CATPart while the graphic properties are.
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Edit/Properties menu (Graphic tab)
For more information about this menu, please refer to the Displaying and Editing Graphic Properties
chapter in the CATIA Infrastructure user's guide.
The images below are only examples.
You can access this menu through Edit/Properties, or through the contextual menu of the element,
or display the Graphic Properties toolbar (View/Toolbars/Graphic Properties).
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or

●

The color displayed in the Graphic Properties toolbar applies to meshes only.

●

The graphic properties are saved in the CATPart.

●

Use Fill/Color and Transparency to modify the color and transparency of meshs:
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Please note that :
●
the color of mesh free edges is yellow, and is not editable,
●

the color of non-manifold edges is white, and is not editable,

●

the default color of scans has changed to cyan.

For a higher transparency quality, go to Tools/Options/Display/Performances and check the High
(Alpha blending) option.
●

●

●

Use Edges/Color, Line type and Thickness to modify the display of scans and grids or of the
triangles of a mesh :

Use Points/Color and Symbol to modify the display of clouds of points:

Use the Pickable check box to make an element pickable or not, and choose the pick option in the
list below.
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Information
This task shows you how to get information on a cloud of points.
Open Info1.CATPart from the samples directory.

1. Click the Information icon

and select a cloud of points.

2. An information box is displayed, with the statistics about the selected cloud:
❍

Bounding box ,and active bounding box,

❍

Number of points, of active points, of selected points, of filtered points,

❍

Total number of triangles and of active triangles.

3. If you select another cloud, the information box is updated with the statistics of that cloud.
4. Push the Close button when you are finished to exit the action.
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Analyzing Distances Between Two Sets of
Elements
This task shows how to analyze the distance between any two geometric elements, or between two sets of
elements.
Open the FreeStyle_11.CATPart document.

1. Select Curve.1.

2. Click the Distance Analysis icon:

The Distance dialog box appears: the Second set state is selected.

3. Select Surface.1.

The distance analysis is computed. Each color identifies all discretization points located at a
distance between two values, as defined in the Color Scale dialog box.

Digitized Shape Editor

●

●

●

●
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When computing the distance between two curves, there is no negative values possible as
opposed to when analyzing the distance between a surface and another element. Indeed,
surfaces present an orientation in all three space directions whereas, in the case of planar
curves for example, only two directions are defined. Therefore the distance is always
expressed with a positive value when analyzing the distance between two curves.
The element which dimension is the smallest (0 for points,1 for curves, 2 for surfaces for
example) is automatically discretized, if needed.
When selecting a set of element, the system compares the greatest dimension of all elements
in each set, and discretizes the one with the smallest dimension.
Use the Invert Analysis button to invert the computation direction. In some cases, when
inverting the computation direction does not make sense, when one of the elements is a plane
for example, the Invert Analysis button is grayed.
If you check the Running point option, you need to move the pointer over the discretized
element to display more precise distance value between the point below the pointer and the
other set of elements.
The projection is visualized and the value is displayed in the geometry area. Note that the
analyzed point is not necessarily a discretized point in this case. This is obvious when a low
discretization value is set, as shown here.

Two analysis modes are available, with corresponding color ramps, provided the Color scale
checkbox is checked.

Digitized Shape Editor
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a. Full (P2 only): activated by the Full color range
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icon, it provides a complete analysis

based on the chosen color range. This allows you to see exactly how the evolution of the distance
is performed on the selected element.

b. Limited: activated by the Limited color range
three values and four colors.

, it provides a simplified analysis, with only

Digitized Shape Editor

Version 5 Release 16

Page 242

Whichever mode you choose the use of the color scale is identical: it lets you define colors in
relation to distance values.
You can define each of the values and color blocks, therefore attributing a color to all elements
which distance falls into to given values.
●

●

The Auto Min Max button enables to automatically update the minimum and maximum values
(and consequently all values between) each time they are modified.
You can right-click on a color in the color scale to display the contextual menu:

❍

❍

❍

●

Edit: it allows you to modify the values in the color range to highlight specific areas of the
selected surface. The Color dialog box is displayed allowing the user to modify the color
range.

Unfreeze: it allows you to perform a linear interpolation between non defined colors.
The unfreezed values are no longer highlighted in green.
No Color: it can be used to simplify the analysis, because it limits the number of displayed
colors in the color scale. In this case, the selected color is hidden, and the section of the
analysis on which that color was applied takes on the neighboring color.

You can also right-click on the value to display the contextual menu:
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Edit: it allows you to modify the edition values. The Value Edition dialog box is displayed:
enter a new value (negative values are allowed) to redefine the color scale, or use the
slider to position the distance value within the allowed range, and click OK.
The value is then frozen, and displayed in a green rectangle.

Use Max/Use Min : it allows you to evenly distribute the color/value interpolation between
the current limit values, on the top/bottom values respectively, rather than keeping it
within default values that may not correspond to the scale of the geometry being analyzed.
Therefore, these limit values are set at a given time, and when the geometry is modified
after setting them, these limit values are not dynamically updated.
The Use Max contextual item is only possible if the maximum value is higher or equal to
the medium value. If not, you first need to unfreeze the medium value.

Only the linear interpolation is allowed, meaning that between two set (or frozen) colors/values,
the distribution is done progressively and evenly.
The color scale settings (colors and values) are saved when exiting the command, meaning the
same values will be set next time you edit a given distance analysis capability.
However, new settings are available with each new distance analysis.
4. Set the distance analysis type (we checked the Auto Scale button and unchecked the Min/Max
values button):

Projection Space

The Projection Space area helps you define the preprocessing of the input elements used for the
computation.
This frame is only available when analyzing distances between curves.

●

●

●

●

3D
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: elements are not modified and the computation is done between the initial elements.

Projection according to the X
,Y
the projection of selected elements.

, or Z

axis: the computation is done between

Projection according to the compass current orientation
between the projection of selected elements.

: the computation is done

Planar distance
: the distance is computed between a curve and the intersection of the
plane containing that curve.

Measurement Direction

The Measurement Direction area provides options to define how set the direction used for the
distance computation.

●
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Normal distance
elements.

: the distance is computed according to the normal to the other set of

●

Direction according to the X

●

Direction according to the compass current orientation

5. Click the

,Y

, or Z

axis.
.

icon to display the 2D diagram distance analysis window. The latter allows to

visualize the distance evolution.
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Drawing modes:

●

●

Vertical Inverse Scale
vertical scale.
Reframe

: to draw the curves in a linear horizontal scale and and inverse

: to reframe the frame.

6. Click More>> in the Distance dialog box to see, and choose further display and discretization
options:
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●

Color scale: to display the Color Scale dialog box whether the full or the limited color range.

●

Statistical distribution: to display the percentage of points between two values.

This option is only available if the Color Scale checkbox is checked.

●

Min/Max values: to display the minimum and maximum distance values and locations on the
geometry.
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●

●

●
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Points: to see the distance analysis in the shape of points only on the geometry (The Spikes
button is unchecked).

Spikes: to see the distance analysis in the shape of spikes on the geometry.
You can further choose to:
❍

set a ratio for the spike size

❍

choose an automatic optimized spike size (Auto scale)

❍

invert the spike visualization on the geometry

❍

display the envelope, that is the curve connecting all spikes together

Use the Texture option to check the analysis using color distribution.

Digitized Shape Editor
●

●

●

●
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This option is only available with surface elements in at least one set, providing this set is
discretized.
The distance is computed from this discretized set to the other set. The texture mapping is
computed on the discretized surface.
It is not advised to use it with planar surfaces or ruled surfaces.
Statistical distribution, Min/Max values, and Points cannot be visualized when using the
Texture option.
The visualization mode should be set to Shading with Texture and Edges, and the
discretization option should be set to a maximum (in Infrastructure User's Guide, see
Improving Performances, the 3D Accuracy -> Fixed option should be set to 0.01).
Check the Material visualization option in the View -> Render Style -> Customize View
command to be able to see the analysis results on the selected element. Otherwise a warning
is issued.

Use the Curve Limits option to relimit the discretized curve.
Two manipulators appear at both extremities of the curve: they let you define new start and
end points on the curve.

Start and end points are defined by a ratio of curve length between 0 and 1. If you extend the
curve for instance, this ratio is kept.

●

Use the Max Distance option to relimit the distance: for example, set the value to 150mm.
The maximum value is displayed accordingly on the geometry.
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Use the Discretization option to reduce or increase the number of points of the second set of
elements taken into account when computing the distance.
Automatic trap: to delimit the second set of points to be taken into account for the
computation, in the case of a large cloud of points, thus improving the performances.
Be careful when using the Automatic trap option with certain cloud configurations, such as
spiralling clouds of points for example, as the automatic trap may remove too many points to
generate consistent results.
In this case, it is best to deactivate the check button.

7. Click OK to exit the analysis while retaining it.

The analysis (identified as Distance Analysis.x) is added to the specification tree.
●

●

●

Even though you exit the analysis, the color scale is retained till you explicitly close is. This is
like a shortcut allowing you to modify one of the analyzed elements, which leads to a dynamic
update of the distance analysis, while viewing the set values/colors at all times and without
having to edit the distance analysis.
When analyzing clouds of points, in normal projection type, the distances are computed as the
normal projection of each point of the first cloud onto the triangle made by the three points
closest to that projection onto the second cloud.
As it is a projection, using the Invert Analysis button does not necessarily gives symmetrical
results.
When you select the geometrical set as an input in the specification tree, all the elements
included in this geometrical set are automatically selected too.

The auto detection capability is available from the Dashboard.
You can calculate the minimum distance between two curves along a direction using the
Knowledge Expert product.
For further information, refer to the Knowledge Expert's User's Guide, Reference, Functions
Package, Measures chapter.
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Transformations
This chapter deals with transformations in Digitized Shape Editor.
Performing a Symmetry on Geometry
Translating Geometry
Rotating Geometry
Transforming Geometry by Scaling
Transforming Geometry by Affinity
Transforming Elements From an Axis to Another
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Performing a Symmetry on Geometry
This functionality is P2 for FreeStyle Shaper, Optimizer, and Profiler.
This task shows you how to transform geometry by means of a symmetry operation.
Open the Transform1.CATPart document.

1. Click the Symmetry icon

.

The Symmetry Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed by symmetry.
3. Select a point, line or plane as Reference element.
The figure below illustrates the resulting symmetry
when the line is used as reference element:

The figure below illustrates the resulting
symmetry when the point is used as
reference element:
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4. Click OK to create the symmetrical element.
The element (identified as Symmetry.xxx) is added to the specification tree.
❍

You can select an axis system as the Element to be transformed, providing it was
previously created.
The element is identified as Symmetry.xxx in the specification tree, however the
associated icon is the axis system's

❍

❍

❍

❍

.

Use the Hide/Show initial element button to hide or show the original element for the
translation.
Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This capability is only available with the Generative Shape Optimizer product.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
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Translating Geometry
This task shows you how to translate one, or more, point, line or surface element.
Open the Translate1.CATPart document.

1. Click the Translate icon

.

The Translate Definition dialog box appears as well as the Tools Palette.
2. Select the Element to be translated.
3. Select the Vector Definition.

Direction, distance
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4. Select a line to take its orientation as the translation direction or a plane to take its normal as the
translation direction.
You can also specify the direction by means of X, Y, Z vector components by using the contextual
menu on the Direction field.
5. Specify the translation Distance by entering a value or using the spinners.

Point to Point

Digitized Shape Editor

4. Select the Start point.
5. Select the End point.

Coordinates
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4. Define the X, Y, and Z coordinates.
In the example besides, we chose 50mm as X, 0mm as Y, and -100 as Z.
5. When the command is launched at creation, the initial value in the Axis System field is the
current local axis system. If no local axis system is current, the field is set to Default.
Whenever you select a local axis system, the translated element's coordinates are changed with
respect to the selected axis system so that the location of the translated element is not changed.
This is not the case with coordinates valuated by formulas: if you select an axis system, the
defined formula remains unchanged.
This option replaces the Coordinates in absolute axis-system option.

6. Click OK to create the translated element.
The element (identified as Translate.xxx) is added to the specification tree.
The original element is unchanged.

●

You can select an axis system as the Element to be translated,
providing it was previously created.
The element is identified as Translate.xxx in the specification
tree, however the associated icon is the axis system's

●

●

●

.

Use the Hide/Show initial element button to hide or show the
original element for the translation.
Choose whether you want the result of the transformation to be a
surface or a volume by switching to either Surface or Volume
option.
This capability is only available with the Generative Shape
Optimizer product.
This switch only concerns volumes since the transformation of a
surface can only be a surface. Thus in case of multi-selection of
volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is grayed out
when editing the feature.
To have further information about volumes, refer to the
corresponding chapter.
Use the Repeat object after OK checkbox to create several
translated surfaces, each separated from the initial surface by a
multiple of the Distance value.
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Simply indicate in the Object Repetition dialog box the number of
instances that should be created and click OK.

●

●

●

●

If you select a solid as the input element, the result will either be
a surface or a volume.
The selection of the feature prevails over the selection of the subelement.
To select a sub-element, you need to apply the ''Geometrical
Element'' filter in the User Selection Filter toolbar.
For further information, refer to the Selecting using a Filter
chapter in the CATIA Infrastructure User's Guide.
You can edit the translated element's parameters. Refer to
Editing Parameters to find out how to display these parameters in
the 3D geometry.
The following capabilities are available: Stacking Commands and
Selecting Using Multi-Output.
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Rotating Geometry
This task shows you how to rotate geometry about an axis.
Open the Transform1.CATPart document.

1. Click the Rotate icon

.

The Rotate Definition dialog box appears as well as the Tools Palette.

2. Define the rotation type:
❍

❍

Axis-Angle (default mode): the rotation axis is defined by a linear element and the angle is
defined by a value that can be modified in the dialog box or in the 3D geometry (by using the
manipulators).
Axis-Two Elements: the rotation axis is defined by a linear element and the angle is defined
by two geometric elements (point, line or plane)
■

Axis/point/point: the angle between the vectors is defined by the selected points and their
orthogonal projection onto the rotation axis.

Digitized Shape Editor

■

Version 5 Release 16

Page 260

Axis/point/line: the angle between the vector is defined by the selected point and its
orthogonal projection onto the rotation axis and the selected line.

■

Axis/point/plane: the angle between the vector is defined by the selected point and its
orthogonal projection onto the rotation axis and the normal to the selected plane.
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■
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Axis/line/line: the angle between the direction vectors of the projection is defined by the
two selected lines in the plane normal to the rotation axis.
In case both lines are parallel to the rotation axis, the angle is defined by the intersection
points of the plane normal to the rotation axis and these lines.

■

Axis/line/plane: the angle is defined between the selected line and the normal to the plane.

Digitized Shape Editor

■

❍
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Axis/plane/plane: the angle is defined between the normals to the two selected planes.

Three Points: the rotation is defined by three points.
■

The rotation axis is defined by the normal of the plane created by the three points passing
through the second point.

■

The rotation angle is defined by the two vectors created by the three points (between
vector Point2-Point1 and vector Point2-Point3):

Digitized Shape Editor
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The orientation of the elements (lines or planes) is visualized in the 3D geometry by a red arrow.
You can click the arrow to invert the orientation and the angle is automatically recomputed. By
default, the arrow is displayed in the direction normal to the feature (line or plane).
For instance, in the plane/plane mode, the arrow is displayed on each plane:

3. Select the Element to be rotated.
4. Select the inputs depending on the chosen rotation type.
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5. Click OK to create the rotated element.
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The element (identified as Rotate.xxx) is added to the specification tree.

Optional Parameters
●

●

Use the Hide/Show initial element button to hide or show the original element for the translation.
Choose whether you want the result of the transformation to be a surface or a volume by switching to
either Surface or Volume option.
This capability is only available with Generative Shape Optimizer.
This switch only concerns volumes since the transformation of a surface can only be a surface. Thus in
case of multi-selection of volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.

●

Use the Repeat object after OK checkbox to create several rotated surfaces, each separated from
the initial surface by a multiple of the Angle value.
Simply indicate in the Object Repetition dialog box the number of instances that should be created and
click OK.

The Repeat object after OK capability is not available with the Axis-Two Elements and
Three Points rotation types.
●

You can select an axis system as the Element to be rotated, providing it was previously created.
The element is identified as Rotate.xxx in the specification tree, however the associated icon is the
axis system's

.
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●

●

●

●
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If you select a solid as the input element, the result will either be a surface or a
volume.
Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the
User Selection Filter toolbar.
For further information, refer to the Selecting Using A Filter chapter in the CATIA
Infrastructure User's Guide.
You can edit the rotated element's parameters. Refer to Editing Parameters to find out
how to display these parameters in the 3D geometry.
The following capabilities are available: Stacking Commands, Selecting Using MultiOutput, Measure Between and Measure Item.
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Transforming Geometry by Scaling
This task shows you how to transform geometry by means of a scaling operation.
Open the Transform1.CATPart document.

1. Click the Scaling icon

.

The Scaling Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed by scaling.
3. Select the scaling Reference point, plane or planar surface.
4. Specify the scaling Ratio by entering a value or using the drag manipulator.
The figure below illustrates the
resulting scaled element when the
plane is used as reference element
(ratio = 2):

5. Click OK to create the scaled element.

The figure below illustrates the resulting scaled element
when the point is used as reference element (ratio = 2):
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The element (identified as Scaling.xxx) is added to the specification tree.
You can use the Repeat object after OK checkbox to create several scaled surfaces, each
separated from the initial surface by a multiple of the initial Ratio value.
Simply indicate in the Object Repetition dialog box the number of instances that should be created
and click OK.

❍

❍

❍

❍

Use the Hide/Show initial element button to hide or show the original element for the
translation.
Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This capability is only available with the Generative Shape Optimizer product.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
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Transforming Geometry by Affinity
This task shows you how to transform geometry by means of an affinity operation.
Open the Transform1.CATPart document.

1. Click the Affinity icon

.

The Affinity Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed by affinity.
3. Specify the characteristics of the Axis system to be used for the affinity operation:
❍

the Origin (Point.1 in the figures below)

❍

the XY plane (the XY plane in the figures below)

❍

the X axis (Line.1 in the figures below).

4. Specify the affinity Ratios by entering the desired X, Y, Z values.
The figure below illustrates the resulting affinity with ratios X = 2, Y =1 and Z=1.
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The figure below illustrates the resulting affinity with ratios X = 2, Y =1 and Z=2.

The figure below illustrates the resulting affinity with ratios X = 2, Y =2.5 and Z=2

5. Click OK to create the affinity element.
The element (identified as Affinity.xxx) is added to the specification tree.

Page 269

Digitized Shape Editor
❍

❍

❍

❍

Version 5 Release 16

Page 270

Use the Hide/Show initial element button to hide or show the original element for the
translation.
Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This capability is only available with the Generative Shape Optimizer product.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
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Transforming Elements
From an Axis to Another
This task shows you how to transform geometry positioned according to a given axis system into a new
axis system. The geometry is duplicated and positioned according to the new axis system. One or more
elements can be transformed at a time, using the standard multi-selection capabilities.
See also Defining an Axis System.
Open the Transform2.CATPart document.

1. Click the Axis To Axis icon

.

The Axis to Axis Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed into a new axis system.

3. Select the initial (Reference) axis system, that is the current one.
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4. Select the Target axis system, that is the one into the element should be positioned.

5. Click OK to create the transformed element.
The new geometry is now positioned into the new axis system.
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The element (identified as Axis to axis transformation.xxx) is added to the specification tree.
❍

❍

Use the Hide/Show initial element button to hide or show the original element for the
translation.
You can select an axis system as the Element to be transformed, providing it was
previously created.
The element is identified as Axis to axis transformation.xxx in the specification tree,
however the associated icon is the axis system's

❍

❍

❍

.

Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
This capability is only available with Generative Shape Optimizer. To have further
information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are also available: Stacking Commands and Selecting Using MultiOutput.
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Working with other Applications
Digitized Shape Editor complies with the following CATIA V5 standards:
Updating Parts
Using the Historical Graph
Creating Datums
Using Points in Generative Shape Design
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Updating Parts
This page explains how and when you should update your design. The following topics are discussed:
●
Overview
●

What Happens When the Update Fails? (scenario)

●

Canceling Updates

●

Interrupting Updates (scenario)

●

Update All Command

Overview
The point of updating a part is to make the application take your very last operation into account. Although some operations
such as confirming the creation of features (clicking OK) do not require you to use the Update command because by default
the application automatically does it, some changes to sketches, features etc. require the rebuild of the part.

To warn you that an update is needed, the application displays the update symbol next to the part's name
geometry in bright red.

and shows the

Keep in mind that:
●

●

To update the feature of your choice, just right-click that feature and select Local Update.
Besides the update modes, you can also choose to visualize the update on the geometry as it is happening by checking the
Activate Local Visualization option from the Tools > Options > Infrastructure > Part Infrastructure, General tab.
In this case, as soon as you have clicked the Update icon
❍
the geometry disappears from the screen;
❍

:

each element is displayed as it is updated, including elements in No Show mode. Once they have been updated, they
remain in No Show mode.

Two Update Modes
To update a part, the application provides two update modes:
●

●

automatic update, available in Tools > Options > Infrastructure > Part Infrastructure. If selected, this option lets
the application update the part when needed.
manual update, available in Tools > Options-> Infrastructure > Part Infrastructure: lets you control the updates of
your design. What you have to do is just click the Update All icon
whenever you wish to integrate modifications.
The Update capability is also available via Edit > Update and the Update contextual menu item. A progression bar
indicates the evolution of the operation.

What Happens When the Update Fails?
Sometimes, the update operation is not straightforward because for instance, you entered inappropriate edit values or because
you deleted a useful geometrical element. In both cases, the application requires you to reconsider your design. The following
scenario exemplifies what you can do in such circumstances.
Open the Update3.CATPart document.
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1. Enter the Sketcher to replace the circular edge of the initial sketch with a line, then return to Part Design.

The application detects that this operation affects the shell. A yellow symbol displays on the feature causing trouble i.e.
the shell in the specification tree. Moreover, a dialog box appears providing the diagnosis of your difficulties and the
preview no longer shows the shell:

To resolve the problem, the dialog box provides the following options. If you wish to rework Shell.1, you can:
❍

Edit it

❍

Deactivate it

❍

Isolate it

❍

Delete it

2. For the purposes of our scenario that is rather simple, click Shell.1 if not already done, then Edit.
The Feature Definition Error window displays, prompting you to change specifications. Moreover, the old face
you have just deleted is now displayed in yellow.
The text Removed Face is displayed in front of the face, thus giving you a better indication of the face that has
been removed. Such a graphic text is now available for Thickness and Union Trim features too.
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3. Click OK to close the window.
The Shell Definition dialog box appears.
4. Click the Faces to remove field if not already done and select the replacing face.

5. Click OK to close the Shell Definition dialog box and obtain a correct part. The shell feature is rebuilt.

Canceling Updates
You can cancel your updates by clicking the Cancel button available in the Updating...dialog box.

Interrupting Updates
This scenario shows you how to update a part and interrupt the update operation on a given feature by means of a useful
message you previously defined.
Open the Update.CATPart document and ensure that the manual update mode is on.
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1. Right-click Hole.1 as the feature from which the update will be interrupted and select the Properties contextual menu
item.
The Properties dialog box is displayed.
2. Check the Associate stop update option. This option stops the update process and displays the memo you entered in
the blank field. This capability is available in manual or automatic update mode.

3. Enter any useful information you want in the blank field. For instance, enter "Fillet needs editing".
4. Click OK to confirm and close the dialog box.
The entity Stop Update.1 is displayed in the specification tree, below Hole.1, indicating that the hole is the last feature
that will be updated before the message window displays.

5. Edit Sketch.1, which will invoke an update operation.
When quitting the Sketcher, the part appears in bright red.

6. Run the update operation by clicking the

icon.

The Updating... as well as the Stop Update message windows are displayed. The Stop Update windows displays your
memo and lets you decide whether you wish to stop the update operation or continue it.
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7. Click Yes to finish.
The part is updated. You can now edit the fillet if you consider it necessary.
Using this capability in automatic update mode, the Stop Update dialog box that displays is merely informative.

8. If you decide not to use this capability any longer, you can either:
❍

right-click Hole.1, select Properties and check the Deactivate stop update option: the update you will perform
will be a basic one. To show that the capability is deactivated for this feature, red parentheses precede Stop
Update.1 in the specification tree:

❍

.

right-click Stop Update.1 and select Delete to delete the capability.

Update All Command
The Update All command synchronizes copied solids linked to external references, but also updates the whole geometry of the
part. For information about external references, refer to Handling Parts in a Multi-document Environment in the Part Design
User's Guide.
There are cases where the command also displays the Replace Viewer window. This window either helps you redefine directions
if needed or is merely informative and therefore lets you check the validity of your geometry.
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Using the Historical Graph

This task shows how to use the Historical Graph.
Open any .CATPart document containing elements.
1. Select the element for which you want to display the historical graph.

2. Click the Show Historical Graph icon
The Historical Graph dialog box appears.

The following icon commands are available:
❍
Add graph
❍

Remove graph

❍

Reframe graph

❍

Surface or Part graph representation

❍

Parameters filter

❍

Constraints filter

3. Just close the dialog box to exit this mode.

.
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Creating Datums
This task shows how to create geometry with the History mode deactivated.
In this case, when you create an element, there are no links to the other entities that were used to
create that element.
1. Click the Create Datum icon
❍

❍

❍

❍

to deactivate the History mode.

It will remain deactivated until you click on the icon again.
If you double-click this icon, the Datum mode is permanent. You only have to click
again the icon to deactivate the mode.
A click on the icon activates the Datum mode for the current or the next command.
The History mode (active or inactive) will remain fixed from one session to another: it is
in fact a setting.
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Using Points in Generative Shape Design
This task shows you how to use points from a cloud of points in Generative Shape Design.
Open the Interoperability.CATPart from the samples directory.
We used the Line Definition for our example, but the operating mode is the same for all creation action requiring points.
1. Select the type of creation from the combo list of the dialog box.
2. Go to the next Point field and choose Create Point from the contextual menu.

3. The Point Definition dialog box is displayed.
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4. Click a point on the cloud. Its coordinates are displayed in the Point Definition dialog box.
Click OK to confirm the creation of this point.
5. In the main dialog box, go to the next Point field and repeat the above steps.
6. If necessary, push the Point icon on the right of the Point field to modify the point you have created:
the Point Definition dialog box is displayed and updated according to your pick on the cloud.
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Managing Geometrical Sets
Geometrical sets enable to gather various features in a same set or sub-set and organize the specification
tree when it becomes too complex or too long. You can put any element you wish in the geometrical set,
it does not have to be structured in a logical way. The order of these elements is not meaningful as their
access as well as their visualization is managed independently and without any rule.
This task shows how to manage geometrical sets within the specification tree. This involves:
●

inserting a geometrical set

●

removing a geometrical set

●

changing body

●

sorting the contents of a geometrical set

●

reordering elements

You will find other useful information in the Managing Groups and Hiding/Showing chapters.
●

●

●

●

You can insert and manipulate geometrical sets in the specification tree in much the same way as you
manage files in folders. For instance, you can copy/paste elements from a geometrical set to a target
geometrical set.
These management functions have no impact on the part geometry.
When loading the Generative Shape Design workbench, a Geometrical Set automatically becomes the
current body.
This also means that only the results of the Hybrid Body, i.e. the result of all the operations performed
on geometry, is visible and not any intermediate state of the Hybrid Body.
You can define the Generative Shape Design feature that is to be seen when working with another
application, such as Generative Structural Analysis for example.
To do this, while in the Generative Shape Design workbench:
1. Choose the Tools -> External View... menu item.
The External View dialog box is displayed.
2. Select the element belonging to a Geometrical Set that should always been seen as the
current element when working with an external application.
3. Click OK in the dialog box.

The selected element will be the visible element in other applications, even if other
elements are created later in the .CATPart document, chronologically speaking.
To check whether an external view element has already been specified, choose the
Tools -> External View... menu item again. The dialog box will display the name of
the currently selected element. This also allows you to change elements through the
selection of another element. Note that you cannot deselect an external view element
and that only one element can be selected at the same time.
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Open any .CATPart document containing Geometrical Sets.
You can also open the GeometricalSets2.CATPart document.

Inserting a Geometrical Set
1. In the specification tree, select an element as the location of the new geometrical set.
This element will be considered as a child of the new geometrical set and can be a geometrical set
or a feature.
2. Select the Insert -> Geometrical Set menu command.
The Insert Geometrical Set dialog box is displayed.
The Features list displays the elements to be contained in the new geometrical set.
3. Enter the name of the new geometrical set.
4. Use the Father drop-down list to choose the body where the new geometrical set is to be inserted.
All destinations present in the document are listed allowing you to select one to be the father
without scanning the specification tree. They can be:
❍

geometrical sets

❍

parts

5. Select additional entities that are to be included in the new geometrical set.

If all selected entities belong to the same geometrical set, the father of the new geometrical
set is automatically set to the father of these entities.
6. Click OK to create the geometrical set at the desired location.
The result is immediate. CATIA displays this new Geometrical Set.x, incrementing its name in
relation to the pre-existing bodies, in the specification tree. It is created after the last current
geometrical set and is underlined, indicating that it is the active geometrical set. The next created
element is created within this geometrical set.
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You cannot create a geometrical set within an ordered geometrical set and vice versa.
You can check the Create a Geometrical Set when creating a new part option in Tools > Options -> Infrastructure -> Part Infrastructure -> Part Document tab if you wish
to create a geometrical set as soon as you create a new part. For more information about
this option, please refer to the Customizing section of the Part Design User's Guide.

Removing a Geometrical Set
Two methods are available:
1. If you want to delete the geometrical set and all its contents:

●

Right-click the geometrical set then select the Delete contextual command.
2. If you want to delete the geometrical set but keep its contents:
This is only possible when the father location of the geometrical set is another geometrical set.
This is not possible when the father location is a root geometrical set.

●

Right-click the desired geometrical set then select the Geometrical Set.x object -> Remove
Geometrical Set contextual command.
The geometrical set is removed and its constituent entities are included in the father geometrical set.
You cannot delete a feature within a geometrical set created on the fly. Indeed this geometrical
set is considered as private and can only be deleted globally.

Moving Elements of a Geometrical Set to a New Body
1. From the specification tree, select the element then choose the Geometrical Set.object ->
Change Geometrical Set... item from the contextual menu.
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Multi-selection of elements of different types is supported. However, note that the
contextual menu is not available, and that you can access this capability using the Edit
menu item.
The Change geometrical set dialog box is displayed, listing all the possible destinations.

2. Select the Destination body where the geometrical set is to be located.
Here we selected GeometricalSet.3.
You can do so by selecting the body in the specification tree, or using the drop-down list from the
dialog box.
By default, if you select a body, the geometrical set is positioned last within the new body.
However, you can select any element in the new body, before which the moved geometrical set
will be located.
3. Select the element above which the one you already selected is to be inserted.
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You can directly select this positioning element. In this case the Destination field is automatically
updated with the Body to which this second element belongs.
4. Click OK to move the geometrical set to the new body.
The element selected first is moved to its new location in the specification tree, but geometry
remains unchanged.

❍

❍

Check the Move unshared parents option to move all parents of the first selected element to
its new location, provided these parents are not shared by any other element of the initial
body.
In this case, all the unshared parents are highlighted prior to the move.
Check the Move all parents option to move all parents of the first selected element to its new
location, regardless of whether these parents are used (shared) by any other element of the
initial body.
In this case, all the parent elements are highlighted prior to the move.
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You can move a whole branch, i.e. a whole body and its contents, at a time.
Here we moved GeometricalSet.3 last in GeometricalSet.1.

You cannot move some elements of a multi-output alone to another body: only the whole
multi-output can be moved.

Sorting the Contents of a Geometrical Set
You may need to sort the contents of a Geometrical Set, when the geometric elements no longer appear
in the logical creation order. In that case, use the Auto-sort capability to reorder the Geometrical Set
contents in the specification tree (geometry itself is not affected).
The Geometrical Set.1 contains two extruded surfaces based on point-point lines. The specification tree
looks like this:
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1. Right-click Geometrical Set.1 from the specification and choose the Geometrical Set.1 object ->
AutoSort command.

Instantly, the contents of the Geometrical Set are reorganized to show the logical creation
process.
The geometry remains unchanged.

Reordering Elements within a Geometrical Set
This capability enables you to reorder elements inside the same geometrical set.
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1. Right-click Geometrical Set.1 from the specification tree and choose the Geometrical Set.1
object -> Reorder Children command.
The Reorder Children dialog box is displayed.
2. Select an element.
3. Use the arrows to move an element up or down.

Reordering Features
The Reorder command allows you to move a feature in a Geometrical Set. These features can be:
●
solids
●

shape features

●

sketches

Replacing Features
This capability is only available on shape features.
Please refer to the Replacing or Moving Elements chapter in the Part Design User's Guide.
To manage this capability, the Do replace only for elements situated after the In Work Object
option is available in Tools -> Options -> Part Infrastructure -> General tab. It allows you to make
the Replace option possible only for features located below the feature in Work Object and in the same
branch.
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Selecting Using Multi-Output
This capability enables to keep the specification of a multi-selection input in a single operation.
It is available with the following functionalities:
●
Intersections
●

Projections

●

All transformations: translation, rotation, symmetry, scaling, affinity and axis to axis

●

split

●

Developed wires

Let's take an example using the Projection and Translation functionalities.
Open the Multi-Output1.CATPart document.

1. Click the Projection icon

.

The Projection Definition dialog box appears, as long as the Tools Palette toolbar.

2. Select Translate.1 as first element to be Projected.
❍

❍

If one element is selected and you select another element, it automatically replaces the
element you selected previously, providing the multi-selection panel is closed.
If several elements are selected and you select another element, it is appended to the
elements list.

The selected element (here Translate.1) is highlighted in the specification tree and in the 3D
geometry.
When you select or edit an element aggregated under the multi-output node, either in the
specification tree or in the 3D geometry, its input is highlighted in the 3D geometry, in the
specification tree, and in the multi-selection panel.
In our example, Project.1 has Translate.1 as input, therefore when you select Project.1 in the
specification tree, Translate.1 is highlighted in the 3D geometry, in the specification tree and in
the multi-selection panel.
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icon to add elements.

The multi-selection dialog box (here Projected) opens.
Multi-selection is now active: all selected elements are displayed in the dialog box.
4. Select Translate.2.

Use the Remove and Replace buttons to modify the elements list.
❍

You can select an element in the list: it is highlighted in the specification tree and in the
3D geometry.

❍

You can select one or more geometrical sets and multi-outputs as inputs of the multiselection.
In that case, all their direct children are selected.

5. Click Close to return to the Projection Definition dialog box.
6. Select Extrude.1 as the Support element.
7. Select Normal as Projection type.
8. Click OK to create the projection elements.
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The projection is identified as Multi Output.1 (Project) in the specification tree.
The created elements are aggregated under Multi Output.1.

You can create several multi-outputs in the specification tree, each one grouping one type of
elements.
9. Click the Translate icon

.

The Translate Definition dialog box appears.

10. Select Translate.1 and Translate.2 as the Elements to be translated.
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11. Select Direction, distance as the Vector Definition.
12. Select Extract.2 as the Direction.
13. Select -50mm as the Distance.
14. Click OK to create the translated element.

The translation is identified as Multi Output.2 (Translate) in the specification tree and appears
below Multi Output.1.
The created elements are aggregated under Multi Output.2.
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When editing a multi-output, you can only select the elements belonging to the multioutput in the specification tree (not in the 3D geometry).
When one or several elements are in error under a multi-output (during creation or
edition), an error message is issued after clicking Preview or OK and displays all
features in error.
You can manually delete or deactivate all the elements of a multi-output. As a
consequence, the multi-output feature disappears from the 3D geometry and erroneous
elements can no longer be generated. Similarly, you can activate all the elements of a
deactivated multi-output.
When editing the multi-output, deactivated features are not displayed.
To have further information, refer to the Deactivating Elements chapter.
Multi-selection is available when editing a single feature: double-click it in the
specification tree and click the bag icon to replace it or add new elements.
Multi-outputs and elements aggregated under a multi-output can be edited separately,
simply by double-clicking it in the specification tree. Elements can be modified (added,
replaced, or removed): the corresponding multi-output automatically updates.
Unshared features are aggregated under the parent command that created them and put
in no show in the specification tree.
Shared features are not aggregated under the parent command.
The datum capability is available. If an element is in error, it cannot be created as a
datum element; only elements that could be generated from the multi-selection are
created.
You can move a multi-output to another body. Note that you cannot move some
elements of the multi-output alone but only the whole multi-output.
To have further information, refer to the Managing Geometrical Sets chapter.
You can copy/paste as result a multi-output:
■
if the paste destination is a geometrical set or a solid body, a geometrical set
containing the multi-output's elements is created
■

if the paste destination is an ordered geometrical set or a solid body, an ordered
geometrical set containing the multi-output's elements is created

Refer to Pasting Using the Paste Special... Command in the CATIA Infrastructure User's
Guide for further information.
❍

If an element of a multi-output is in error while being updated, the multi-output itself
appears in the Update Diagnosis dialog box. Note that you can delete the multi-output,
not the erroneous element.
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Workbench Description
This chapter describes the menus, sub-menus, items and toolbars of the Digitized Shape Editor.

Menu Bar
Creation Toolbars
Cloud Display Options
Specification Tree
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Menu Bar
This chapter describes the menus available in Digitized Shape Processor.
Other menus are documented in the Infrastructure User's Guide.

Start SmarTeam File Edit View Insert Tools Windows Help

Start

Starts the
Digitized
Shape Editor
Workbench

View

For

See

Toolbars

Creation Toolbars

Digitized Shape Editor
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For the other menu items,
please refer to the Infrastructure
User's Guide.

Insert
Geometrical set

Managing
Geometrical Sets

Ordered geometrical set

Managing
Ordered
eometrical Sets

Cloud Import

Importing Files

Cloud Export

Exporting Cloud
of Points

Cloud Edition

Cloud Edition

Reposit

Reposit

Mesh

Mesh

Operations

Operations

Scan Creation

Scan Creation

Curve Creation

Curve Creation

Analysis

Analysis

Transformations

Transformations

WireFrame

WireFrame

Cloud Edition
Activation
Cloud Filter

Activating a
Portion of
a Cloud of Points
Filtering a Cloud
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Remove Point
Protect Cell
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Removing
Elements
Protecting
Characteristic
Lines

Reposit

Align with Previous
Transformation

Aligning using
the Compass
Aligning a Cloud
with Constraints
Aligning Clouds
using Spheres
Aligning Clouds
Aligning a Cloud
with a Surface
Aligning a Cloud
with Points
Use Align
Transformation

Mesh Creation

Mesh Creation

Offset

Offsetting the
Mesh

Rough Offset

Rough Offset

Flip Edges

Flip Edges

Mesh Smoothing

Smoothing
Meshes

Mesh Cleaner

Mesh Cleaner

Fill Holes

Filling Holes on
Meshes

Interactive Triangle Creation

Interactive
Triangle Creation

Decimation

Decimating
Meshes

Optimize

Optimize

Clouds Union

Merging Clouds
of Points

Meshes Merge

Merging Meshes

Align using the compass
Align with Constraints
Align using Spheres
Align with Cloud
Align with Surface
Align with Points

Mesh

Operations

Digitized Shape Editor
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Split

Splitting Meshes

Trim/Split

Trim/Split

Projection on Plane

Projection on
Plane

Scan Creation
Curve Projection
Planar Sections
Scan on Cloud
Free Edges

Projecting Curves
Cutting a Cloud
of Points or
a Polygon by
Planar Sections
Creating Scans
Creating Free
Edges

Curve Creation
3D Curve
Curve from Scans

3D Curve or 3D
Curve on Scans
Curve from
Scans

Analysis
Information

Distance Analysis

Information
Analyzing
Distances
between
two Sets of
Elements

Transformations
Translate
Rotate
Symmetry

Scaling

Translating
Geometry
Rotating
Geometry
Performing a
Symmetry on
Geometry
Transforming
Geometry by
Scaling
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Affinity

Axis to Axis
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Transforming
Geometry by
Affinity
Transforming
Elements from an
Axis to Another

WireFrame
Point

Creating Points

Line

Creating Lines

Plane

Creating Planes

Circle

Creating Circle

For the other menu items, please refer to the Infrastructure User's Guide.
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Insert Toolbars
They are the following:
Geometrical Sets
Import and Export
Cloud Edition
Reposit
Mesh
Operations
Scan Creation
Curve Creation
Analysis
Transformations
WireFrame
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Geometrical Sets
For

See

Geometrical Sets

Managing Geometrical Sets

Ordered geometrical set Managing Ordered Geometrical Sets
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Import and Export
For

See

Import Importing Files
Export Exporting a Cloud of Points
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Cloud Edition
For

See

Activate Activating a Portion of a Cloud of Points
Filter

Filtering a Cloud

Remove Removing Elements
Protect Protecting Characteristic Lines
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Reposit
For

See

Align using the compass

Aligning using the Compass

Align with Constraints

Aligning Clouds with Constraints

Align using Spheres

Aligning Clouds using Spheres

Align with Cloud

Aligning Clouds

Align with Surface

Aligning a Cloud with a Surface

Align with Points

Aligning a Cloud with Points

Align with Previous Transformation

Use Align Transformation
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Mesh
For

See

Mesh Creation

Mesh Creation

Offset

Offsetting the Mesh

Rough Offset

Rough Offset

Flip Edges

Flip Edges

Mesh Smoothing

Smoothing Meshes

Mesh Cleaner

Mesh Cleaner

Fill Holes

Filling Holes on Meshes

Interactive Triangle Creation Interactive Triangle Creation
Decimation

Decimating Meshes

Optimize

Optimizing Meshes
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Operations
For

See
Merge Clouds

Merging Clouds of Points

Meshes Merge

Merging Meshes

Split a Mesh or a Cloud

Splitting Meshes

Trim/Split

Trim/Split

Projection on Plane

Projection on Plane
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Scan Creation
For

See

Project Curves

Projecting Curves

Planar Sections

Cutting a Cloud of Points or a Polygon by Planar Sections

Create Scans on Cloud Creating Scans
Create Free Edges

Creating Free Edges
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Curve Creation
For

See

3D Curve

Creating 3D Associative Curves or Creating 3D Associative Curves on a Scan Of Cloud

Curve from scans Curve from Scans
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Analysis
For

See

Information

Information

Distance Analysis Analyzing Distances between two Sets of Elements
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Transformations
For:

See:

Translate

Translating Geometry

Rotate

Rotating Geometry

Symmetry

Performing a Symmetry on Geometry

Scaling

Transforming Geometry by Scaling

Affinity

Transforming Geometry by Affinity

Axis to Axis Transforming Elements from an Axis to Another
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WireFrame
For

See

Point Creating Points
Line

Creating Lines

Plane Creating Planes
Circle Creating Circle
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Cloud Display Options
For

See

Cloud Display Display Options and Graphic Properties
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Specification Tree
The specification tree portion specific to Digitized Shape Editor looks like this:
●

●

●

When you import a cloud of points, it is created in an Geometrical Set. The results of the following actions
are placed in this Geometrical Set, by default. You can create other Geometrical Sets or Groups to order the
elements according to your needs.
The icon

indicates that the element is a cloud of points.

The name of an element is made of the name of the action and a number, except for the import where the
name of the input file is kept..

Icon

Action

Icon

Action

Geometrical
Sets

Group

Import

Mesh
Creation

Flip Edges

Mesh
Smoothing

Create
Scans on
Cloud

Project
Curves

Merge
Clouds

Merge
Meshes

Split a
Mesh or a
Cloud

Planar
Sections

Split in
Mesh
Cleaner

Trim/Split

Offset

Rough
Offset

3D Curve

Create
Free
Edges
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Symmetry

Curve
from
Scans

Scaling

Axis to
Axis

Translate

Rotate

Distance
Analysis

Affinity
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Glossary

A
activate

This function is used to define a particular portion of a cloud for further operations.

align

This function is used to reposition several clouds of points to each other in order to
reconstruct a complete object.

C
cloud of points

A cloud of points is defined as a set of points in 3D space. It may consist of a single point
or several million of points. Those points may be the result of a digitizing or of a
computing operation.
In the current manual, the term cloud of points refer to several representations:

cell

●

representation as a set of points,

●

representation as a set of lines of points (or scans),

●

representation as a set of grids,

●

representation as a mesh.

A cloud of points may consist of several cells (i.e. sub-clouds): for example, the cloud of
points representing the handle below consists of two cells.

characteristic line They are particular lines corresponding for instance to curvature variations (fillets
start/end) or sharp edges, ...
cloud to align

In actions aligning clouds, the cloud to align is the cloud that is moved to be repositioned
on another element.

constraint,
In the action Align with constraints, setting a constraint consists in pairing two elements,
constraint element one on the cloud to align, the second on the reference, to define the repositioning. Those
two elements are called constraint element.
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F
filtering

Filtering a cloud of points is a method to create a lighter working context: some points
are hidden, thus making further operations on the cloud quicker. Those hidden points can
be recalled later.

flipping edge

An edge common to two triangles of a polygon may be flipped, that is rotated, to respect
the shape a sharp edge of the meshed part.

M
mesh

A mesh consists of a set of polygonal faces (triangles) which represent the surface of a
3D model. A triangulation is computed to describe the neighborhood relation of all points.
A mesh can be used to check the quality of the points, or can be processed in other
applications.
A mesh may present some irregularities such as:
●

Corrupted triangles, i.e. triangles that have the same vertex twice,

●

Duplicated triangles, i.e. triangles that share the same three vertices,

●

Non-manifold edges, i.e. edges shared by more than two triangles,

●

Non-manifold vertices, i.e. vertices shared by two or more connected shells.

A mesh may also present some structural problems such as:
●

Orientation problems, i.e. all the triangles are not oriented in the same direction,

●

Isolated triangles, i.e. triangles belonging to small connected areas of the mesh,

Version 5 Release 16
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●

Disconnected zones, i.e. the mesh is made of several disconnected zones,

●

Triangles with long edges.
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N
neighborhood

Many functions in Digitized Shape Editor operate on the points in space, regardless of the
organization of the data in the cloud. In these functions, you can specify a maximum
distance (neighborhood) which will be considered around a point for the operation. The
larger the neighborhood value, the more points will be considered, and possibly the
operation may become slower.
A default neighborhood value is proposed in those functions.

R
reference

In actions aligning clouds, the reference is the target, i.e. the element on which a cloud
will be repositioned.

remove

This function deletes physically points from the cloud of points. The points can not be
recovered.

S

Digitized Shape Editor
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scan

Cloud of points can be organized in consecutive scans, that is points in parallel planes.

sampling

This operation is performed while importing a cloud of point. You can choose to import
only a percentage of the points of the cloud.

shading

A mesh can be visualized in shaded mode. This mode is a method for visualizing the
point data and getting an impression of its quality.

W
working distance

This is the distance beyond which the elements are not taken into account for a
computation.
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Index
Numerics
3D Curve
3D Curve on Scan

A
adaptive
filter
add
align with constraints
adding split points
curve from scans
affinity
align cloud
with a cloud
align using spheres
constrained
selective display
align using the compass
display
move
selective display
align with cloud
cloud to align
output
selective display
statistics
align with constraints
add
clear all
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delete
output
selective display
align with points
cloud to align
output
statistics
align with previous transformation
align with surface
cloud to align
output
statistics
analysis
optimize
porcupine curvature
analyze
mesh cleaner
analyzing
curvature
distance between elements
ascii
export
associative curve
creating
AutoSort Geometrical Set
command
axis to axis

B
bounding box
import
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C
canceling
Update
cgo
export
chordal deviation
decimation
chordal error
project curves
clear all
align with constraints
cloud display
cloud display options
graphic properties
polyline and point
sampling
triangles
cloud display options
cloud display
cloud to align
align with cloud
align with points
align with surface
color scale
command
3D Curve
Activate
Affinity
Align using Spheres
align using the compass
Align with Cloud
Align with Constraints
Align with Points
Align with Previous Transformation
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Align with Surface
AutoSort Geometrical Set
Axis to Axis
Change Body
Cloud Display
Create Datum
Create Free Edges
Curve from Scans
Decimation
Distance Analysis
Export
Fill Holes
Filter
Flip Edges
Import
Information
Insert Geometrical Set
Interactive Triangle Creation
Merge Clouds
Merge Meshes
Mesh Cleaner
Mesh Creation
Mesh Regeneration
New
Offset
Optimize
Planar Sections
Porcupine Curvature Analysis
Project Curves
Projection on Plane
Properties
Protect
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Remove
Remove Geometrical Set
Reorder Body
Rotate
Rough Offset
Save as
Scaling
Scan on Cloud
Show Historical Graph
Split a Mesh or a Cloud
Symmetry
Translate
Update
constrain on element
curve from scans
constrained
align using spheres
meshing
contextual menu item
Properties
create curves
planar sections
project curves
creating
associative curve
datum
elements by affinity
elements by rotation
elements by scaling
elements by symmetry
creating free edge scans
offsetting the mesh
current triangle count
decimation
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curvature
analyzing
curvature analysis
curve from scans
curve from scans
adding split points
constrain on element
curvature analysis
interpolation
max. order
max. segments
maximum deviation
maximum order
smoothing
split angle
tolerance
cutting elements
trim/split

D
decimation
chordal deviation
current triangle count
edge length
free edge deviation
target percentage
target triangle count
delete
align with constraints
deletion
mesh cleaner
delimitors
import
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depth
flip edges
dihedral angle
optimize
direction
import
rough offset
display
align using the compass
distance analysis
distinct
mesh cleaner

E
edge length
decimation
elements
translating
elements by affinity
creating
export
ascii
cgo
stl

F
facets
import
fill holes
hole size
points insertion
sag
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selection of holes
shape
step
Filter
Physical Removal
Reset
Sphere
filter
adaptive
max. distance
physical removal
reset
flip edges
depth
formats
import
free edge deviation
decimation
free edges
import

G
granularity
rough offset
graphic properties
cloud display
grouped
import
mesh cleaner
guide
planar sections
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H
historical graph
hole size
fill holes

I
import
bounding box
delimitors
direction
facets
formats
free edges
grouped
minimal point quality
statistics
system
update
influence area
planar sections
input
interactive triangle creation
Insert Geometrical Set
command
inserting
geometrical sets
interactive triangle creation
input
output
interpolation
curve from scans
interrupting
Update

Version 5 Release 16

Page 330

Digitized Shape Editor

isolated triangles
mesh cleaner

L
limiting curve
planar sections
long edges
mesh cleaner

M
managing
geometrical sets
max deviation
mesh smoothing
max. distance
filter
max. order
curve from scans
max. segments
curve from scans
maximum deviation
curve from scans
maximum length
optimize
maximum order
curve from scans
merging clouds
mesh cleaner
analyze
deletion
distinct
grouped
isolated triangles
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long edges
orientation
preview colors
split in connected zones
statistics
structure
mesh smoothing
max deviation
meshing
constrained
mode
neighborhood
sphere
minimal point quality
import
minimum length
optimize
mode
meshing
move
align using the compass
moving
geometrical sets

N
neighborhood
meshing

O
offset distance
rough offset
offsetting the mesh
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creating free edge scans
optimize
analysis
dihedral angle
maximum length
minimum length
orientation
mesh cleaner
output
align with cloud
align with constraints
align with points
align with surface
interactive triangle creation

P
Physical Removal
Filter
physical removal
filter
pick
remove
planar sections
create curves
guide
influence area
limiting curve
scan type
points insertion
fill holes
polygonal
trap
polyline and point
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cloud display
porcupine curvature
analysis
porcupine curvature analysis
preview colors
mesh cleaner
project curves
chordal error
create curves
projection direction
type of projection
working distance
projection direction
project curves
projection type
trim/split
Properties
contextual menu item
protection

R
rectangular
trap
remove
pick
trap
Remove Geometrical Set
command
removing
geometrical sets
Reorder Body
command
reordering
geometrical sets
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Reset
Filter
reset
filter
rotate
rough offset
direction
granularity
offset distance

S
sag
fill holes
sampling
cloud display
scaling
scan
scan type
planar sections
selecting
using multi-output
selection of holes
fill holes
selective display
align using spheres
align using the compass
align with cloud
align with constraints
shape
fill holes
smoothing
curve from scans
sorting
geometrical sets
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Sphere
Filter
sphere
meshing
spline
trap
split angle
curve from scans
split in connected zones
mesh cleaner
statistics
align with cloud
align with points
align with surface
import
mesh cleaner
step
fill holes
stl
export
structure
mesh cleaner
symmetry
system
import

T
target percentage
decimation
target triangle count
decimation
tolerance
curve from scans
translate
translating
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elements
trap
polygonal
rectangular
remove
spline
triangles
cloud display
trim/split
cutting elements
projection type
type of projection
project curves

U
Update
canceling
command
interrupting
update
import

W
with a cloud
align cloud
working distance
project curves
working with other applications
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